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With MOOSE PETERSON

Modern Day Wildlife Photography

Moose Peterson
Wildlife Photographer, Author and Educator

Moose’s true passion has always been and remains photographing the life history of our endangered 
wildlife and wild places. Since 1981 he and his wife Sharon have dedicated their lives to this pursuit. 
Educating the public about our wild heritage is their hallmark. Moose’s aviation photography has the 
same goal of preserving our aviation heritage and the freedoms they protect, pictorial and oral for 

future generations. Along the way Moose has been honored for his photographic passion: a Nikon Ambassador USA, 
Lexar Elite Photographer, recipient of the John Muir Conservation Award, Research Associate with the Endangered 
Species Recovery Program, just to name a few. He was part of Epson’s Finish Strong ad campaign. Moose was the 
creative producer/photographer of his acclaimed film: Warbirds and The Men Who Flew Them. He shares his knowl-
edge through his writing, being published in over 143 magazines worldwide, author of 28 books including his latest, 
Photographic FUNdamentals, Taking Flight and best seller Captured. He lectures across the country to thousands 
upon thousands of photographers every year. One of the original Nikon shooters to receive the D1 in 1999, Moose 
embraced this new technology, becoming the only wildlife photographer in the world to shoot strictly digital in the 
early years. While a beta site for all the major hardware and software manufacturers, Moose continues being a cre-
ative innovator of new techniques both behind the camera and the computer, which is the driving force behind his 
photography and goals.

There are so many good wildlife photographers out there today, wow! That is 
so cool and is a celebration unto itself. And yet, we need more! We need the 
next generation to come up, tackle the genre with a determination of crafts-
manship and love to share to make a difference in our world. I’m often asked 
why I say I’m not an “eyeball” wildlife photographer but a visual storyteller. 
I’m often asked what’s the difference. Well, here’s my answer in a long-winded 
explanation wrapped up in simply saying, modern-day wildlife photography.

Passion pays?
It poured all night! The blind leaked and it was like a Chinese water torture as 
the drops slowly dropped on my forehead as I tried to shrink down into my 
sleeping bag to stay warm and dry. The evening before, the shoot had been a 
total zip as in, didn’t take a single frame which is a first in five years. We hoped 
the morning would be better but so far, it wasn’t looking too good. By the time 
the alarm went off, the foot end of my sleeping bag was soaked and I was not 
a happy camper. In the dark, we slowly got ready for the sunrise and as the 
light started to grow in the east, we opened the window of the blind. There out 
on the Platt River were the Lesser Sandhill Cranes, thousands of them. Then 
at 06:45 before there was enough light to shoot a Bald Eagle glided down 
the center of the river. In front of him the thousands of cranes raised from the 
water and left so a couple of minutes later, all we had in front of us was water, 
not a single bird. After being locked in the blind for fourteen hours, we didn’t 
have a single image!

Later that day finds us back, locked in the blind at 4:30 PM. There are no 
storms in the forecast so at least we’ll stay dry but we still have at least six-
teen hours locked in the blind to look forward to. After a few hours, the cranes 
started flying by as they leave the fields they have been feeding in and look for 
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where they are going to spend the night on the river. It’s never the same place 
day to day so it’s sheer luck if they land in front of your blind. Then the first 
crane lands and it’s within lens reach and within another ten minutes, there are 
five to ten thousand cranes in front of us. It was the most spectacular sunset 
we’d ever experienced in the blind as the cranes came into the river. By the 
time the sun rises the next morning, there are at least fifteen thousand cranes 
in front of our blind and after five years of working towards this moment, it has 
finally presented itself. Within the next ninety minutes, three thousand images 
are in the can of a spectacle that is like no other on the planet!

The goals of a wildlife photographer
Wildlife photography is so much more than just the one lucky or planned 
single click portrait. Don’t get me wrong, there is nothing wrong with serendip-
ity when it produces the killer image. It’s just that the long-term rewards from 
wildlife photography come from the long-term investment in the knowledge 
and pursuit of our wild heritage. My point to this story is that this whole expe-
rience came about because I got close physically and used optics to isolate! 
I got close because I work with biologists involved with this endangered spe-
cies. I got close because of over a decade or working with kit fox at the den, 
which has earned me the respect and trust to be at the den of an endangered 
species. I can’t imagine doing anything else with my life!  This is the lost art of 
wildlife photography.

Way back when we were really young, we all had that one influential English 
teacher. The one thing mine pounded into my head was a very important lesson. 
“To write about a subject, you have to know the subject.” Wildlife photography 
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is EXACTLY the same! You’ve got to know your subject to get close physically. 
I can’t stress that enough! If you want to make the most of your short lens or 
get the most out of your telephoto, you’ve got to know the subject. You can 
cut the distance between you and the subject by HALF if you know basic biol-
ogy. It’s what I lump into the phrase basic biology. Now keep in mind I’ve never 
taken one class in biology, I’ve learned it all in the field, working with the best 
biologists in the world and being a student of wildlife. Without any further ado, 
let’s get to it!

Knowing Basic Biology
Where’s the best place to start absorbing basic biology? From that favorite 
armchair, of course. Learning basic biology can be done by simply watching 
television. This day and age, there are really lots of great programs (and some 
that really suck, especially on grizzly bears) that can aid you in your quest for 
knowledge. Though many nature programs are staged, the actions of the wild-
life are nonetheless genuine. The learning that can be done by watching and 
observing is amazing! I still watch and learn from them.

There are many examples of the great programming, such as numerous excel-
lent programs on hummingbirds, one of my favorite subjects. By watching 
them on television, we can see how they approach and retreat from a flower 
when feeding. We can also get a feel for how long they spend feeding on one 
flower. We can take this knowledge into the field and prefocus and preframe 
on a flower in preparation for the bird’s arrival. By understanding that they 
come in low to a flower and hover, we’ve increased our opportunities to suc-
cessfully photograph them!
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One area of photography most wildlife photographers don’t venture into is 
nocturnal. If you want to see what you’re missing, ideas of where to go and 
when and what you might find, just watch any one of the many great programs 
on nocturnal wildlife. I have taped many of these programs strictly because of 
the insightful information they contain. It has saved me years of painful trial 
and error, working with a truly unseen subject!

There is more learning to be gleaned from watching television. The moving 
images on television provide insight into the animal’s behavior and how it uses 
its habitat. It gives hints as to the time of day the species is active and any 
associated problems, photographing during that time of day. The observant TV 
watcher can see how the species communicates its actions prior to executing 
them, something that all wildlife does that we can use to our advantage! It can 
even provide possible clues where to go to photograph that particular species.
You need to start filling the shelves of your mental library (and office library as 
well) with what I term nature trivia. Reading is the best way to do this. There 
are, for example, many excellent magazines on birding. Birder’s World and Bird 
Watcher’s Digest are two excellent magazines that discuss the world of birds, 
where to find them, their habits and in many cases, how others have gotten 
close to them. (Unfortunately, comparable magazines devoted to mammals 
aren’t available but you might try Nature, Smithsonian or Natural History for 
their occasional look at mammals.)

These are great beginning references, but there are even more specialized maga-
zines called journals, which provide a wealth of information (many can be found 
on the web as well). The AUK, The Condor, Journal of Mammology and Journal of 
Conservation Biology plus tons more are written by the scientific community for 
peer review. It isn’t necessary to be a rocket scientist to understand what’s written. 
The methods section of these papers are particularly useful.

In this day and age, the web can be a killer locale to find biological material. 
Do a search for the species name, birds or mammals in general as well as the 
state game department where you live. The real trick to getting the most out 
of these pages is to READ them carefully and explore the links they provide. 
Too many folks want instant answers from a website and do not take the time 
to read and explore them. I can guarantee you that the web is an incredible 
wealth of biological information you can find and trust. I know I do on a nearly 
daily basis.

For example, suppose you want to photograph the nocturnal habits of a kan-
garoo rat. Look up kangaroo rat in general or the specific species in the index 
and find the papers that deal with that topic. Next, the method section in that 
paper will outline how kangaroo rats are found, what is used to lure them, what 
time at night they come out, what time of the year is best to see them and if 
there are any special precautions needed to protect their welfare. A further 



6

Modern Day Wildlife Photography
With MOOSE PETERSON notes

reading might reveal such added insight as key behavior to anticipate and pho-
tograph. In fact, if you search on this particular subject on the web, the major-
ity of the time you’ll find the articles illustrated with my kangaroo rat photos. 
The info is out there in book, magazine, journal and web form. You’ve just got 
to do a little homework!

Reading specific books on a species to be photographed will further open 
doors to its biology. One of the wildlife photographer’s greatest resources is 
the library of the local natural history museum. I was very fortunate to have 
one of the best in Santa Barbara where I spent hundreds of hours reading. 
Librarians in these specialized libraries can point out the most current books 
on the species you’re researching and in many instances know of current arti-
cles and other resources available to aid you. 

Many state wildlife departments (such as California Department of Fish and 
Game in my home state) and the U.S. Fish and Wildlife Service publish reports 
on a wide variety of topics, covering our natural heritage. Many of these free 
publications can add a great deal of understanding of basic biology. This is one 
of the greatest untapped resources available to everyone. They also have huge 
websites with many of their own journals and biological descriptions online. 
One note of caution, these sources are usually dated by the time you read 
them. Check the published date of the books and the dates of the research 
in the journals. Even though the information was extremely accurate when it 
was done, don’t think of it as the final word on the subject. I can’t remind you 
enough, this is a constant learning process, no one has all the answers!
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I personally have a huge library of reference books in my office (NHBS 
Environmental Bookstore is my secret source http://www.nhbs.com/ for 
books). There are a number of publications that only a crazed soul like myself 
would want, but others are basics, which all wildlife photographers should have 
on their shelves. The first is a bird identification book such as Sibley’s or the 
National Geographic’s. This should also include volumes on mammals, reptiles 
or insects if that’s your interest. Not only do these books tell how to identify a 
particular species, they also provide general biological information.

Those who are interested in birds must have A Field Guide to Nests, Eggs, and 
Nestlings of North American Birds. This book provides critical information on 
the nesting biology of all the birds in North America. It gives nest location and 
season, incubation, nestling and fledging times, parenting behavior and much 
more. This is a must in every wildlife photographer’s library!

Before you even leave the house, become a general expert on the species. 
Once you leave the house, you can compare what you’ve read with what you’re 
seeing and fill in the holes not covered in your reading. One thing most rarely 
gotten from book learning is generally termed as “reading sign.”

Reading sign is really no more than observing and understanding what wild-
life are communicating. A good example involves raptors and their defecation. 
Just before a raptor (hawk, eagle or owl) is about to leave its perch and take 
flight, it will get rid of a little extra weight by defecating. So, when approaching 
a raptor and it defecates, be aware it’s about to take flight and take the appro-
priate action.
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On that same note are the clues whitewash leaves behind. You find a locale 
with lots of whitewash, what does that tell you? You know it’s a place where 
a raptor often perches. You want to get the shot, you just need to wait. What 
about whitewash and little pieces of bone or skull, what does that tell you? It 
tells you that it’s a perch for an owl more than likely. What about finding a lot 
of whitewash on the ground at the base of a tree? If you look up the tree to 
find the source of the whitewash and you find a nesting cavity, you’ve found an 
active nest. This is how I found a nesting Northern Sawhet Owl’s nest one year.
Reading sign doesn’t require putting on a coonskin cap and becoming Davy 
Crockett. Listening to the call of a bird, tracking its origin and retaining the 
information is lots of fun. Learning calls can also be key in knowing if an owl 
is in the area and if jays are mobbing the owl. This is just one example of how 
easily detected and useful sign can be in photography.

Reading sign also comes in direct forms. When approaching a wild animal, it 
communicates in no uncertain terms what it’s feeling about your encroach-
ment. The one thing we hope to see and have communicated to us is the one 
time glance by the critter and then a return to activity. It is only by careful 
study and observation of the subject can we safely and successfully get close 
to the subject! Getting close requires that you always, always, always watch the 
subject! They will tell you, I guarantee you, always just what they’re thinking. 
The trick as it were, is to be able to read that sign!

I’ve already mentioned how raptors defecate before taking flight. Many birds 
will fluff up their feathers when they’re uncomfortable. Some birds will change 
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which foot they are standing on prior to leaving. That’s if they don’t just start 
moving away. Many times, birds do what is called displaced aggression. When 
a bird is feeling stressed by an outside presence, it will act very nervously and 
take out its frustration on a mate, another bird, twig or leaf. 

Mammals have various ways of showing their discomfort, most being com-
municated through the eyes and ears. If you’re working with a cow Moose and 
she lowers her ears, you’d best know she is not just disturbed but is probably 
pissed off. A good example of this can be found in the elk photos that follow.

No photograph is worth risking the welfare of any subject! 
Knowing basic biology enables you to understand the signs I’ve just mentioned 
plus the hundreds of others that let us know we’re doing something right or 
wrong. This prevents careless accidents and injury to wildlife. As I said, know-
ing basic biology is just understanding what wildlife is communicating.

The biggest photographic benefit in knowing basic biology is getting close physi-
cally. By knowing what a critter might be communicating you can act accordingly, 
which includes knowing which direction to head or not, as well as how close you 
can get. You still might be wondering just how this all falls into place, basic biol-
ogy and getting close physically, so let’s discuss a couple of scenarios.

During the spring, wildlife does what comes naturally, the birds and bees thing. 
During this time of courtship, males especially are interested in finding a mate. 
(Sex is one of the best things to have on your subject’s mind when you’re 
trying to get close physically.) During this time of, let’s call it preoccupation, 
males throw caution to the wind and for photographers, this means getting in 
close physically is a whole lot simpler. 
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Understanding the different bird species styles in attracting mates is of enor-
mous value. Each species has a different methodology of attracting a mate. 
If it’s drumming from a particular log, then you have an idea where to set up. 
If it requires singing from atop a perch, once you find that perch, you know 
the male will constantly return to it. Males establish territories quite often and 
defend them against other males. They constantly traverse their territory sing-
ing from chosen perches. Knowing this, you can find the best perch for pho-
tography and set up on it instead of chasing the bird.

During the nesting season, knowing basic biology permits you to sleep in. 
Males tend to sing when there’s sun and it’s not windy or breezy. When that 
alarm clock goes off and you look out your window and you don’t see the sun 
or it’s breezy, you can go back to sleep, knowing that the males won’t be out 
singing. Just be sure that the weather at your house is the same as that where 
the birds live and you’ll be OK. This doesn’t hold true though, at other times of 
the year nor for mammals. 

Certain species only display their special ornamentation during the breeding 
season. The male Greater Sage Grouse only fans his tail and inflates his air sacs 
for a brief period during the spring. The male Red-winged Blackbird only flash-
es his red shoulder patches during the spring. If the goal is to capture these 
seasonal shows, you’d better understand when and how these species display 
to attract their mates.

Mammals are a little more difficult. Males don’t tend to flash bright colors or sing 
from atop a perch. Mating also takes place for many mammals in late fall rather 
than in spring as with birds. Elk bugle for mates and have their shoving matches 
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in late fall. The mighty clashes of bighorn sheep ring through the mountains in 
late fall as do the sounds of tangled mule deer antlers. Be aware that mammals 
with antlers (deer, elk, moose) shed their antlers in late winter to early spring. 
Photographs of a bull Moose with a large rack are best shot in late fall once 
they have shed their velvet and are in their prime. A bull without its rack at first 
glance by the public looks like a cow. If you want a bull photo, then you need 
to be at the right place at the right time to capture the rack!

You won’t miss events if you keep in mind you live on a round planet. In Alaska, 
in the northern latitudes, for example, the breeding season for birds runs typi-
cally from June to July whereas, in Southern California and Florida, it’s more 
likely to be in early April. Doing basic research on the nesting or mating biol-
ogy of a species will reveal such information thereby preventing the mistake of 
traveling to a region for events which are past or have yet to occur.

There is really a threefold benefit to knowing basic biology: getting in close 
physically, getting better photographs and protecting the welfare of the wild-
life. Getting in close physically is an obvious benefit to better photographs. 
Simply by cutting down the distance between the subject and the camera by 
half, a 400mm lens can have the effective magnification of an 800mm lens. 
But understanding basic biology has other, potentially greater benefits than 
just getting in close physically for better photographs.

One of the greatest benefits of understanding basic biology is knowing when 
an event is going to happen. One of the biggest reasons I work with biologists 
is because their knowledge aids me in capturing those unique moments on 
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film (as well as in safeguarding the species’ welfare). Let’s face it, only so many 
wildlife portraits can be taken. The most exciting photographs and challenges 
in wildlife photography come from capturing the wildlife in action. If through 
basic biology an understanding that the subject is communicating its next 
action, capturing that action on film is not such a challenge. Knowing that a 
subject is going to move and having an idea what direction and when you can 
have yourself and gear ready in a heartbeat to capture it. You’ll find that learn-
ing basic biology not only benefits your photography but also it’s fun!
This seems so obvious, yet it’s still one of the greatest untapped principles in 
wildlife photography. Set your camera’s motordrive to Continuous! 

A heron is in the 
Everglades standing per-
fectly still in the water 
with a gaze piercing the 
surface. You’d better 
have that motordrive set 
to astro blast and the 
metering set because at 
any second that heron 
is going to stab in the 
water to catch a fish. 
This means you need to 
be prepared! You need 
the fastest shutter speed 
available, enough room 
in the frame for the neck 
of the heron to grab the 
fish and not be out of 
the frame as well as any 
other compositional con-
siderations you need to 
make prior to the action. 
Knowing basic biology 
has you prepared to cap-
ture the event!

A coyote prowls a mead-
ow. Suddenly it stops and 
cocks its ears straight 
forward. Slowly it looks down, pointing its nose like an arrow. Once again, have 
the camera’s motordrive set to astro blast, metering set and room in the frame 
for the coyote to first jump up and then out. By its movements, the coyote is 
telling you it’s heard a vole and is zeroing in on the noise. Homework is done, 
you know coyotes pounce on prey like a cat, up and then out. Know your basic 
biology so this marvelous event goes home on film and not just as a memory!
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You’ll get better photographs by knowing basic biology and proper equipment 
selection. You should only travel into the field with the equipment needed for 
that particular shoot. For example, you probably wouldn’t use a 600mm lens 
to photograph a hummingbird’s nest or try to use a 200mm to photograph 
an eagle’s nest. Likewise, going to photograph kangaroo rats, you wouldn’t go 
without a flash. Understanding the basic biology of the subject lets you prepare 
for any possible problems that might arise when photographing it. This, in turn, 
allows you to travel light, carrying only the equipment you need. The moral is, 
take all your gear with you to the locale but only take that equipment into the 
field that solves the immediate problems of getting the particular photograph.
The welfare of the species is the biggest reward in understanding basic biol-
ogy. Ethics in wildlife photography is a gray area where there are no written 
guidelines for every possible situation. But the gray area never has to be a 
problem if you understand basic biology. You’ll never stress or harass wildlife 
(which is illegal and ends up showing in your photographs) if you understand 
what it’s communicating. You’ll never worry if you were responsible for a nest 
failure or a young calf being taken as prey if you understand basic biology. 
You’ll never have to worry that you’re part of this huge problem rather than 
part of the solution!

Basic biology can also add to your personal protection. A grizzly mauling a pho-
tographer, this is nearly an annual event and has always been the fault of the 
photographer doing something they should have known not to do. An elk or 
bison goring a photographer, a rattlesnake biting a photographer. - these need 
never happen if the individuals understand basic biology. You can get close 
enough to Bison in Yellowstone to photograph them with a 20mm, so why take 
the risk when you know they just love goring tourists! And for goodness sake, 
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never chase a bear, especially a grizzly over a ridge. Not only are you risking 
your own safety, but that of the griz if the grizzly does anything to protect itself 
from you. No photograph is worth risking the welfare of any wildlife!

Techniques
Success in getting close starts before leaving the house. Aftershave, perfume, 
scented deodorants, scented laundry detergent and other unnatural scents 
won’t help in getting close. They don’t guarantee you won’t be able to get close, 
but they can make the difference when you’re working with an already shy sub-
ject. Picture the dirt cloud that surrounds Pig Pen and then imagine it as a scent 
and you have an idea of the cloud of smells around you. I’m not saying leave the 
house never showering or washing your clothes or the need to roll around in the 
dirt once on site. I’m recommending unscented products. Leave smelling good 
for when you get back home. Rolling around in the grass or buying hunting 
scents are not required to get close. Just be neutral smelling.

The next consideration is the equipment you’re dragging, I mean carrying, into 
the field. You should be carrying only the equipment you need for that particu-
lar photographic adventure. What about those times when you’re just going 
out to see what’s about and have nothing specific in mind to photograph? You 
should still take what you’d use for photographing either birds, mammals, flow-
ers or bugs but not your whole camera bag. The goal is to minimize our own 
profile so we blend in better with the world around us.

One of the great benefits of shooting digital is the ability to slim down! Not 
having to wear a photo vest with bulging pockets of film, sticking out from 
my side and making noise is just fantastic! I can carry nearly the equivalent of 
100 rolls of film in a case that fits into a shirt pocket by shooting digital. I wear 
a small fanny bag that hides behind me so my profile is as small as it can be 
while still leaving me able to operate photographically.

I once watched a photographer loaded to the gills with equipment approach 
an incredible scene with two gray foxes. They were completely wrapped up 
in playing in the sun and had no idea that anyone was watching. Since the 
other photographer had seen them first and was already approaching them, I 
just stood back and watched the moment. Well, he got right up on the foxes 
and had a great shot in front of them. He slowly and properly took his tripod-
mounted rig from his shoulder and set it down. Just then the camera bag, 
hanging from his shoulder slipped down his arm. He jerked to catch it but it 
was too late, the foxes were alerted to his presence and were gone in a flash.

Limit what you’re carrying and how you’re carrying it. Fanny packs are a good 
example. Most are made of nylon, which is a drawback. Their buckles can be the 
biggest problem. The “click” noise of the buckle as it’s coupled or uncoupled is 
at the perfect frequency for mammals’ hearing. I don’t know if it’s the same as a 
snapping branch or just super foreign, but they run from that noise lickity split!
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Naturally, you might be asking if knowing basic biology allows you to just walk 
right up to wildlife. Well, not exactly. There’s a little more to it than just walk-
ing up and taking the photograph. In summation, it requires physically moving 
closer to wildlife, stalking.

Moving Closer to Wildlife - Stalking 
Stalking is a term with a fuzzy past with connotations of having to be a ninja 
photographer. Traditionally, stalking is thought of as a process of moving closer 
to wildlife by using every rock, bush and/or tree for cover, requiring some 
elaborate zig-zag walking strategy to hide behind each obstacle. Who’s kid-
ding who? Are most animals so stupid that they don’t know when a person is 
approaching them, especially a pesky photographer? Besides, what subject 
hangs around long enough for such antics?

Yes, there are times when wildlife turns a blind eye to the photographer. And 
thank goodness, or else we wouldn’t get the photographs we do. The point is 
to use sound basic biology and not some stalking voodoo to get close physi-
cally. This basically means that when I’m out shooting, I tend to walk straight 
towards the subject. And let’s face it, there are very few rocks or trees that are 
going to hide me, carrying a 600mm lens on my shoulder. I might use an avail-
able shrub or rock if it’s on the path towards the subject, but I don’t go out of 
my way to use them. The wildlife will either stick or flee with my actions hope-
fully putting the wildlife at ease and so remain. 
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Before even starting the stalk, here are a few guidelines. First, do you have 
any camera straps dangling from your camera or lens barrel? These are strong 
vertical lines, something wildlife especially wary mammals look for. If it’s a 
shy subject and you have a strap swaying as you’re walking, you might not 
get close. Next, are there any natural obstacles between you and the subject? 
Water, holes, logs or any other obstacle, which must be circumnavigated deter-
mines in part your path. Mentally map out a path, one with the least obstacles 
to hamper a graceful approach and then select a stopping point where the 
desired image size can be captured. Lastly, we must make sure that our actions 
will not jeopardize the subject’s welfare.

With all of this thought through we can start approaching the subject. Always 
keep in mind that whether it’s a mammal or bird, that at any moment it could just 
disappear and we’re skunked. That’s part of the game. More than likely higher 
percentage of stalks are successful if we’ve done our homework. This is due to 
the fact that each individual subject has its own zone of safety. When we recog-
nize the sign of this zone we avoid entering it and causing the subject to take 
flight. A knowledge of basic biology enables us to see the signs of flight before 
they happen and gets us the best possible photographs from the situation. Right?!

Many people concern themselves with being up, down or crosswind during 
a stalk. This may get them close or maybe not. Make the most of the experi-
ence by approaching in the direction that gets the best photograph (generally 
determined by the light more than any other factor). What good is getting in 
close coming downwind if the resulting photograph fails because of lighting, 
background, or any other distraction. Hey, the whole purpose of photography 
is to have fun so remember that sometimes the great photograph just won’t 
happen. With neutral smell and an understanding of basic biology, the chances 
are good for that close approach no matter which way the wind blows.

When handholding the camera, stalking is a lot simpler. Walk with even, slow-
paced strides avoiding at all costs fast, short, jerky steps. Smooth, fluid steps 
(avoiding any twigs if at all possible) put the wildlife more at ease. The camera 
should already be just below chin level so that the motion of bringing it to the 
eye is minimal. Raise the camera to your eye in a slow, fluid motion, keeping 
elbows tucked in, focusing and operating the camera in a like manner. Any 
sharp, quick movements imitate the movement of predators just prior to a 
strike. As far as the subject is concerned a stalking photographer is a predator. 
They’re unaware that no harm is intended by the photographer.

The handholding photographer is able to walk a much easier path compared 
to one with a tripod rig. For this reason, stalking is easiest when handholding 
since there is so much more flexibility in movement. For example, walking over 
a fallen log is not an option available to the tripod-bound photographer. The 
speed of taking the shot is much greater for the handheld photographer as 
well, since they can have an instant response time to any action on the part of 
the subject.
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The advantage of the tripod-bound photographer is the tripod with its mount-
ed lens. The fallen tree, boulders strewn stream and other natural obstacles 
might impede progress, but the tripod and its shape more than make up for it. 
Wildlife generally understands that an upright shape with two legs is a human 
(predator). This frightens them. But with the tripod and lens in tow, that basic 
form is broken up, ever so slightly, but enough to decrease the chances of 
spooking the prey. This is especially true if you arm press the tripod, carrying 
it directly in front of you. This really breaks up the human form and in many 
instances increases the zone around a critter in which it feels safe. This permits 
you to physically get closer.

There are two ways to physically carry a tripod-bound camera setup. For 
covering long distances, the “over the shoulder” approach is best. The tripod 
legs are either spread wide open if space permits or the legs are closed up. In 
either case, the legs are extended to the correct height for shooting. Before 
the shooting range is reached, slowly and smoothly lower the rig from the 
shoulder by lowering the body rather than lifting the rig high over the head. 
Lower it and set it up in a smooth fashion. Make sure everything is ready to 
shoot. (When setting the tripod down, avoid setting the legs on any small 
rocks, which might give way, cause noise and provide an unsteady platform to 
work from.) 

With the tripod set up and aimed at and the subject, advance slowly. This is 
done by picking up the tripod by just raising it slightly off the ground and 
moving it up slowly at arm’s length, setting it down and walking up behind it. 
What’s going on is that the animal is connecting with the tripod and setting 
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it as its safety zone limit. (Remember this is a generalization from basic biol-
ogy.) As long as the photographer stays behind the tripod, that safety zone is 
preserved. This will give the animal the feeling of being “safe”. This process of 
moving closer is carried out until the appropriate distance is reached (or the 
wildlife leaves).

One thing to always keep in mind while approaching wildlife is that massive 
gazing eye, the lens. The front element of a 122mm or 160mm class lens is like 
a giant eye that, believe or not, winks. To observe this, set it up and look at it 
from the subject’s point of view. When your eye is behind the viewfinder and 
viewing through the lens, the “eye” or lens is just a big, dark circle. But when 
your eye is removed from the viewfinder, light streams through the viewfinder 
eyepiece and through the front element. Now the eye is a big white circle. Put 
your eye back to the viewfinder and it turns black again. It winks! Most photog-
raphers are constantly looking through their lens, then they’re not, then they 
are, then not. Black, white, black, white. This will make anything nervous and 
a shy subject flee! If there is any question that this is happening, just close the 
viewfinder eyepiece curtain when not using the viewfinder so that the “eye” is 
always dark.

Speaking of eyes, keep an eye open not only when shooting but also when 
walking through an area. Normally where there’s one subject, there are more. 
We’ve all heard the saying there’s safety in numbers. Well, wildlife is no excep-
tion. It’s easy to be so completely and totally zeroed-in on the one subject that 
obvious secondary wildlife is totally missed! Basic biology won’t help here, 
good eyes and ears and a mind that’s open and alert to the environment will. 

This also means distinguishing the movement of wildlife when hidden. The 
breeze can play tricks on a stalking photographer whose concentration is on 
any movement. Be aware of the habitat and its response to a breeze. Most 
inanimate objects move in a fluid motion in a breeze. A bird on the other 
hand when moving about a bush will cause the vegetation to move in a sharp, 
jerking motion as it passes from branch to branch. Sounds of mammals pass-
ing underneath brush make sharp noises rather than the mellow sounds of 
a  breeze rustling the branches. Your ears are a critical tool for getting close 
physically to wildlife!

Listening is a very important part of stalking. This includes hearing the noises 
made by wildlife and your own noise. Each species of bird has its own iden-
tifying call plus a variety of other calls used for communication. Knowing the 
difference between a normal call and a warning call is important. Many small 
mammals make very high pitched warning calls that sound very much like bird 
calls. Be able to distinguish these sounds in order to take advantage of them 
for better photographs.



19

notes

Sounds in the wilds are also important in getting close physically. The sound 
of a branch falling on the ground as opposed to a branch being stepped on by 
a large predator, the sound of a distant creek from the wind whistling through 
the pines, the scrapping on the pine tree caused by a limb rubbing on the bark 
rather than a northern flying squirrel scampering up that same tree - distin-
guishing among these is vital in stalking.

Biologists have devised a number of techniques for surveying native habitat. 
One method is directly applicable to photography. It has been determined that 
to accurately survey a particular location, the biologist must arrive at a spot 
and remain there silently for at least ten minutes. This ten minute adjustment 
period is the time required for wildlife to adjust to the presence of the biologist 
before going back to a normal routine. 

When traveling through any area where no wildlife is readily seen, stop for ten 
minutes. During this time, prepare the equipment to shoot. Listen for the area’s 
return to life as it adjusts to a foreign presence. Shooting opportunities should 
occur in a relatively short time or at a short distance away. This basic tech-
nique comes right from the methods sections of biological journals. It doesn’t 
guarantee great photographs but does provide the best possible odds for tak-
ing a photograph. Combine biology with technology, using basic biology is the 
key to your success!
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With LINDSAY ADLER

High Impact Images: Create Photos that WOW

Lindsay Adler
Portrait and Fashion Photographer

Fashion photographer Lindsay Adler has risen to the top of her industry as both a photographer 
and educator. Based in New York City, her fashion editorials have appeared in numerous fashion 
and photography publications including Marie Claire, InStyle, Noise Magazine, Zink Magazine, 
Rangefinder, Professional Photographer and dozens more. As a photographic educator, she is one 

of the most sought-after speakers internationally, teaching on the industry’s largest platforms and most presti-
gious events. A clean, bold and graphic style has become the hallmark of her work, whether shooting advertising 
campaigns, designer-look books, jewelry lines, hair campaigns, fashion editorials, or professional athletes. Lindsay 
is renowned for her creativity and collaborating with designers and stylists in order to create fresh looks. An 
author of four books, she is always working on new ways to share her passions and knowledge with others. Each 
year she teaches to tens of thousands of photographers world-wide through prestigious events.

Concept: 
n    Always start with purpose. The purpose and concept of your image help 

make ALL creative decisions. 

Style: 
n   Consistent and recognizable visual themes through your body of work
n   Subject Matter + Visual + Emotional 

Impact: 
n   Creating “eye-catching,” “scroll-stopping” imagery 
n   Important to stand out, for marketing and winning photo competitions
n   Using multiple elements of impact together for most memorable imagery 

Elements of Impact: 
n   Color
   t Emotion, direct the eye
n   Emotion
   t Interact with an image with your heart, not just eyes 
n   Composition
   t Reinforce emotion and feeling of the scene 
n   Light
   t Mood, direct the eye
n   Movement 
   t Create a moment and energy instead of static frame
n   Subject Matter 
   t  Shoot more compelling subjects, props, styling, etc. to create more memo-

rable work 

Think Ahead: 
n   Plan shooting think about how you can better utilize color, movement, and 

memorable subject matter
n   Create mood boards or plan shoots, instead of relying only on spontaneity  
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With RICK SAMMON

Adding Impact to In-Camera Images

Welcome to Photoshop World 2018. So glad you are here – and reading this 
article and hopefully attending my classes.
 
This article/class is about the image-making process, from idea to image. I’ll 
share a few examples here (due to space), but several more in my class. But first, 
I’d like to start with what I call, “My One Picture Promise,” which I promise you 
will help you make better pictures and give you a greater number of keepers.
 
My One Picture Promise 
If you think about the one picture you’d take in a particular situation – think 
about the one best exposure, the one best composition, the one best lens to 
use, the one best set of camera settings – I promise you, you will get a higher 
percentage of “keepers.”

Rick Sammon
Photographer, Educator and Author

Rick Sammon, a Canon Explorer of Light, has published 36 paper books, including Secrets of HDR 
Photography, Exploring the Light, and Digital Photography Secrets. Rick also has three apps on 
the iTunes store: Rick Sammon’s 24/7 Photo Buffet - an e-book that offers 24/7 access to Rick’s 
best photo tips, tricks and techniques. Rick Sammon’s Social Media Marketing for Photographers, 

a series of Quick Time movies that features Rick’s tips on Social Media. Rick Sammon’s Life Lessons We Can Learn 
From Mother Nature, a collection of Rick’s favorite wildlife photographs accompanied by inspirational quotes. Mini-
lessons on wildlife photography are also included, as well as quick Photoshop tips. Rick’s book, Flying Flowers won 
the coveted Golden Light Award, and his book Hide and See Under the Sea won the Ben Franklin Award. Rick, 
who has photographed in almost 200 countries around the world, gives more than two-dozen photography work-
shops (including private workshops) and presentations around the world each year. Rick co-founded the Digital 
Photography Experience (www.dpexperience.com) with Juan Pons. DPE is on-line digital photography learning 
center that offers podcasts and articles - and more! Rick, who has been nominated for the Photoshop Hall of Fame, 
is considered one of today’s top digital -imaging experts, cutting through lots of Photoshop “speak,” making it fun, 
easy and rewarding to work and play in the digital darkroom When asked about his photo specialty, Rick says, “My 
specialty is not specializing.” See www.ricksammon.info and www.dpexperience.com for more information.
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My promise works for my photo workshop students and I am sure it will work for 
you – because it forces you to be a little more thoughtful and careful before you 
press the shutter release button.
 
The image of the king penguins that opens this epilog is my favorite photograph 
from South Georgia Island. Here is why I like the photograph, which I took while 
I was lying on my belly in penguin poop, and the reasons why I feel as though it 
was the best photograph to take in this situation:
n  the image tells an environmental story, as opposed to a close-up shot that tells 

more of a story about the animals;
n  the entire image is properly exposed;
n  the penguins’ heads are framed in the sky and are separated from the back-

ground;
n  the three penguins are placed off-center for creative composition;
n  the three penguins also illustrate one of the rules of composition: the rule of odds;
n  the scene shows the land and sky all in focus.
 
Following are two pictures, snapshots, of the same animals in the same situa-
tion. I share them with you to illustrate what can happen if you shoot before you 
think.

The three penguins are positioned off center for pleasing composition but their 
heads are lost in the background.
 

With RICK SAMMON

Adding Impact to In-Camera Images
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I took this picture while I was standing straight up. Photographing from that 
angle made this a cluttered and boring photograph.

Speaking of one...
here is one of the 
many photo tips I 
learned from pho-
tographer Art Wolfe: 
When photograph-
ing several animals, 
look for one animal 
that is doing some-
thing different from 
the other animals. 
This picture is the 
result of following 
Art’s advice.

With RICK SAMMON

Adding Impact to In-Camera Images
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Here is another way to think 
about my one-picture promise: 
slow down. Don’t always be in 
such a rush to grab a shot.
 
Here is a photograph to help 
you remember my one-picture 
promise. I took this picture in 
1976 in Hong Kong. The man is 
reminding me to pay him one 
dollar for a photograph.
 

Image: As Time Goes By
Location: Palouse, Washington 
State.
Goal: Make a photograph that 
illustrates a bygone time in the 
Palouse.
Thought process: Use HDR 
(High Dynamic Range) imaging 
to capture the contrast range 
of the scene – the bright areas 
outside the truck and the dark areas inside the truck.
Behind-the-scenes story: One rainy afternoon, while exploring and photograph-
ing the back roads of the Palouse, I stumbled upon an abandoned farmhouse. 
Parked in the front yard was an old, rusting tuck. Seeing these two elements, I 
knew there was a photograph to be made – a photograph that told a story of 
yesteryear in the Palouse.
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Basic HDR Image Capture Tips: Entire books have been written on HDR (and 
I’ve written one of them: HDR Photography Secrets). For now, here are the 
basics of HDR image capture:
 
n  Take enough pictures – over and under the average exposure – to capture the 

entire dynamic range of the scene (three exposures in my farmhouse/truck 
image and six exposures in the red truck example at the end of this chapter);

n  Often times, the following bracketing sequence can capture the contrast range 
of the scene: 0 EV, +2 EV and -2 EV. That’s what I used for my farmhouse/truck 
image. In the red truck image (taken in Socorro, New Mexico) at the end of 
this chapter, I used the following bracketing sequence (due to the much higher 
contrast range): 0 EV, -2 EV, -3 EV, -4 EV, + 1 EV and +2 EV. I actually shot 
another exposure at +3 EV but did not need it to create my HDR image. The 
idea: just to be safe in very high contrast situations, shoot more images than 
you think you need. Don’t use them if you don’t need them.

n  In-camera HDR (in-camera capture and in-camera process) works well if the 
contrasts range of the scene it not greater than about four f-stops. In higher 
contrast range situations, more exposures are needed – the more contrast, the 
more exposures. When using in-camera HDR processing, the camera creates 
the HDR effect (contrast, color and so on). In Lightroom (and in Photoshop 
and with HDR plug-ins and stand alone programs), you have much more cre-
ated and corrective control over the final HDR image;

n  The aperture must remain the same throughout your HDR bracketed sequence;
n  Use a tripod when you can’t hold your camera steady for the series of images. 

The HDR images in this chapter were all created from hand-held bracketed 
sequences.
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Image Lightroom HDR Processing Technique
After importing your images into the Develop Module, select all and go to Photo 
> Photo Merge > HDR.

You’ll see a win-
dow that gives 
you a preview 
of your HDR 
image. Note: it’s 
only a preview. 
More adjust-
ments await you 
(if you want) in 
Lightroom and 
with plug-ins. 
Click Merge.
 

 

Lightroom creates a new file, an HDR file, from your bracketed image. In this 
screen grab, you can see the default adjustment that Lightroom made on the 
new image:
n Increased Exposure;
n Reduced the Highlights;
n Opened up the Shadows;
n Increased the Whites;
n Increased the Blacks.
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In this case, I was pleased with the HDR image. Had I wanted to make addi-
tional corrections, I could easily have accomplished that goal with additional 
Lightroom adjustments.
 
I liked the exposure but was not happy with the “feel” of the image. Again, I was 
looking for an image that created the mood of yesteryear.
 
I opened my image in Nik Color Efex Pro and added the Strong Sepia effect in 
the Color Stylizer filter. The opening image for this chapter is the result of my 
combining my Lightroom-generated HDR image with the Nik Color Efex filter.
Continuing my 
evolution-of-an-
image process, 
I wanted to add 
a stronger old-
time look to 
my image. Here 
is the result of 
applying the 
Wet Plate filter 
in Nik Silver 
Efex Pro to my 
HDR image. It’s 
not my favorite 
rendition of the 
image but I’m 
sharing it with you to encourage you to experiment.
  
Outtake
Here is the first 
shot I took (to 
illustrate a point) 
at the scene. 
Basically, it’s a 
compositional 
mess. Sure, the 
bullet holes in 
the windshield 
are cool, but all 
the elements 
are bunched 
together. There 
is no separation 
between the objects in the scene. In the opening image, you can see that the 
farmhouse is perfectly framed by the window and that the rearview mirror is not 
blocking the main part of the farmhouse.
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All that was no accident: I opened the door and moved the mirror to make a 
pleasing composition.
 
Image: Jewels of the Sea

Location: Black beach opposite the Jokusarlon Glacier Lagoon, Iceland.
 
Goal: Convey the beauty of the grounded icebergs – gems of frozen water 
– framed by the slow and graceful moving surf and positioned against a back-
ground of powerful, crashing waves.
 
Thought process: Compose a scene that includes the icebergs, the beach, the 
waves, and the sky. Experiment with different slow shutter speeds, from 1/60th 
second to several seconds, to convey the power and beauty of nature.
 
Behind-the-scenes story
I took my Jewels of the Sea photograph on my October 2015 Iceland photo 
workshop. The previous day, before we set out to shoot on the beach, I gave the 
workshop participants the assignment of trying to get an image of grounded 
icebergs framed by moving water – an image that captured the beauty of the 
Icelandic coast.
 
When we arrived on site, my focus was on helping the workshop participants so 
I really did not get a shot I liked.
 
One workshop participant, David Recht, however, nailed the shot, which he 
showed me during our evening processing session. His black-and-white photo-
graph inspired me to get a similar photograph the following day.
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My Favorite Shot
I took dozens of photographs of the same scene, from a single position that 
morning on the beach (see the screen grab of some of the other shots in the 
Outtakes section below). The opening image for this illustration is my favorite 
shot for several reasons, the most important being the mood and feeling of the 
image, created by overcast sky, beautiful jewels of ice, and the movement of 
the waves.
 
I also like the movement of the incoming waves on the beach and the burst of 
water on the iceberg in the background. I also like the way the foreground ice-
berg frames the background iceberg.
 
Logistic Tips
Here’s a 
behind-the-
scenes shot 
my wife Susan 
took of me 
while I was 
photographing 
on the beach 
that morn-
ing, just down 
the beach 
from where 
I took my 
Jewels of the 
Sea photograph. I am wearing NEOS – waterproof, flexible and collapsible 
boots that fit over hiking boots and shoes. If you plan to shoot on the beach, 
or in and around water, I recommend NEOS, which come in different sizes and 
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heights, as well as insulated and non-insulated models. NEOS are available from 
OutdoorPhotoGear.com.
 
When you are shooting on the beach, remember this important tip at ALL times: 
Never turn your back on the ocean. A “sneaker wave” may sneak up on you, and 
you and your camera may get drenched, or even knocked over.
 
Basic Moving-Water Photography Tips
When shooting in the sand, unscrew or unlock the smallest legs of your tripod 
first and place the feet of those small legs in the same. If you unscrew/unlock 
the largest legs first and place them in the sand, sand will get in the joints of the 
smaller legs, which can cause screwing/locking/sticking problems. When you 
get back to your hotel room, shower with your tripod, legs extended, to remove 
sand and salt spray.
 
If your tripod is set up in the surf, pay very careful to tripod vibration, which you 
can feel by holding a leg of your tripod. The movement of the waves ebbing and 
flowing can cause your tripod to vibrate, as well as to sink slightly into the sand. 
During a long shutter speed setting, that movement would cause a blurry photo-
graph. For a steady shot, shoot when there is no moving water around the legs 
of your tripod.
 
Wind can also cause tripod vibration, which can be exaggerated when a camera 
strap is attached to your camera. When shooting in the wind with your camera 
mounted a tripod, remove the camera strap for a steadier shot.
 
Wind and waves also equal salt spray. Always have a microfiber cloth handy to 
clean the front element your lens. If it’s very windy, it’s a good idea to have a 
plastic camera on hand to protect your camera.
 
Once your camera is set up, it’s time to shoot. Basically, you want to control/
reduce the amount of light entering your lens so you can shoot at slow shutter 
speeds to blur the water. On bright days, that means using an ND (neutral den-
sity) filter.
 
I use 3-stop and 6-stop and Breakthrough Photography ND filters, which let me 
reduce the light entering my camera. Usually, the brighter the light, the darker 
the filter.)
 
If you don’t want to invest in an ND filter, you can use Mother Nature’s ND filter: 
a very overcast sky or shooting before sunrise and after sunset, when the light 
level is low.
 
The key to getting the desired effect is to experiment with different slow shutter 
speeds. What’s the idea shutter speed? The answer is, of course, “It depends.” 
It depends on your desired effect (amount the water is blurred), how fast the 
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water is moving, and the direction in which the water is moving (incoming or 
outgoing). It also depends on what lens you are using and how close you are 
to the water – because the closer you are to the water, the faster it appears to 
move. For this image, I used a shutter speed of 1/6th second.
 
To capture subtle differences in the waves, set your camera on rapid frame 
advance, as high/fast as it goes.
 
When you think you’ve got a shot, keep shooting – because everything looks 
good on a small screen.
 
Image Processing Techniques
Here’s a black 
and white version 
(for this book) of 
my original color 
raw file. Yes, it’s a 
bit dark and flat, 
but I intention-
ally underexposed 
the image to 
prevent the high-
lights from being 
overexposed 
and washed out, 
which is easy to 
do when you have 
lots of white areas 
(foam in this case) in the frame.
 
After opening my file 
in Lightroom, I only 
made some basic 
adjustments, because 
I was striving for a 
realistic looking mage, 
as opposed to an 
artistic impression of 
the scene.
 
These before-and-
after screen grabs of 
the Lightroom Basic 
adjust panel show the 
adjustments I made:
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n Increased the exposure slightly (note the change in the histogram);
n Increased the contrast – for a more dramatic image;
n Reduced the highlight – to maintain detail in the highlight areas;
n Boosted the blacks – for a richer image.

I also used the Clone Stamp tool to remove the blurred sea gulls in the sky, 
which looked more like dust spots than flying birds.
 
As a final 
step, I 
sharpened 
the image. 
Sharpening 
adds appar-
ent contrast 
to an image.

Here’s the 
result (origi-
nally in color 
but in black-
and-white 
for this book) of my Lightroom adjustments. I like the effect but I still wanted a 
more dramatic image. I felt, in part thanks to David, as though black-and-white 
was the answer.
 

From Lightroom, I opened my image in Nik Silver Efex Pro (Lightroom > Photo 
> Edit In > Nik Silver Efex Pro). Once in Nik, I applied the Full Dynamic Range/
Harsh filter, and then boosted the contrast a bit to create a greater sense of 
drama in the image. I experimented with different color filters, which change 
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the tones and contrast of an image but decided to go with no filter, which is the 
default setting. The opening image is the result of that final enhancement.
 
Outtakes  

Here’s a look at some of the other RAW images from the shoot. Only the image 
I selected as my favorite had, to me, the right combination of water movement 
and crashing wave to make my shot my one keeper.
 
Closing 
Thought
When you are 
shooting with 
other photog-
raphers, watch 
what they are 
doing, even if 
they are not pros. 
You may just be 
inspired to create 
a gem, or jewel, 
of an image.
 
Postscript
Here’s a with-
and-without 
(with and with-
out the surf in 
the foreground) 
pair of images 
that illustrate the 
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one of the main reasons for shooting by the sea: including the moving water in 
your picture for an image with impact. This pair of images, taken a few minutes 
after I took the opening image, illustrates something equally important: timing is 
everything.
 
Image: A Mother’s Love

Location: Maasia Mara, Kenya
 
Goal: Capture the intimacy of the lioness and her cubs in the beautiful early 
morning light.
 
Thought process: The sun was low in the sky, so when I saw the lions, I knew a 
photograph with beautiful back lighting was possible. Photographically, because 
I was shooting on the AV (aperture priority mode) I knew I had to set my 
Exposure Compensation at EV -1 (for starters) to avoid overexposing the backlit 
areas of the animals. Logistically, I knew our safari vehicle driver was the key to 
getting me into a good position.
 
Behind-the-scenes story
Early one morning, while we were on a game drive, my guide Simon pointed out 
the lioness and her cubs as they walked across the Mara – at a distance of about 
three football fields from our safari vehicle.
 
Simon said, “Let’s wait here and see where they go.” Lucky for us, they started 
to walk almost directly toward our vehicle. Or maybe it wasn’t luck after all. 
Simon was familiar these animals and their habitat and habits so my guess is 
that he knew exactly where they were going.
 
As the animals proceeded to walk toward our vehicle, I started to shoot but the 
light was just okay. I asked Simon to change position so I could shoot so the ani-
mals were backlit.
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To condense this story, Simon moved the vehicle into a good shooting position 
six times during the course of about 20 minutes as the lioness and cubs strolled 
across the Mara. He wanted me to get the shot as much as I did.
 
As you will see in the screen grab below of the photographs from the encounter, 
the light and the background kept changing. Lucky for me, Simon knew exactly 
where to position our vehicle for the perfect, backlit photograph.
 
My Favorite Shot
Out of all the photographs that I took that morning, the image that opens this 
chapter is the only “keeper” for me. The light is perfect, there is separation 
between the animals, all the animals have their eyes open, the cubs are look-
ing at me, and I like the positions of all the lions’ legs (bent legs add a sense of 
motion to a still photograph).
 
Basic Photography Tips
To get a good exposure of animals (or people) in a backlit situation, the key is 
not to over expose the bright area of the scene, the “rim light” you see around 
the heads of the lions in this example. When shooting on the AV (aperture prior-
ity) mode, as I was, start by setting your exposure compensation at EV -1. That’s 
necessary because all the darker areas in the frame will fool your camera’s light 
meter into thinking the scene is darker than it is, which will result in those high-
lights being blown out.
 
The same exposure compensation recommendation goes for shooting in the 
Tv (shutter priority) mode. If you shoot in the manual mode, set either the 
aperture or shutter speed to one f/stop under the recommended setting, 
again for starters.
 
I started at EV -1 but because I didn’t want to underexposure more than neces-
sary (because noise is increased the more you underexpose), I found that EV 
-0.33 was sufficient to get a good exposure.
 
Also, you must shoot RAW files because more detail can be recovered from 
shadow and highlight areas in RAW files than in JPEG files.
 
When shooting into the sun, make sure to use your lens hood, which can keep 
direct light off the front element of your lens. Even a little bit of direct light fall-
ing on your lens can result in a loss of contrast in a photograph. If your lens 
hood is not long enough, shade your lens with your hand or a hat.
 
Image Processing Technique
My RAW file shows a third cub. Because I thought that cub set off the balance 
of the photograph, I decided to crop it out.
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After cropping, I only made a few minor Lightroom adjustments:
n Decreased the exposure – for a better exposure of the highlights;
n Decreased the Highlights – for a better exposure the highlights;
n Open up the shadows – to better see the animals’ faces;
n Closed out some of the distracting background elements – for a cleaner shot.
 
After making those adjustments, I selected a Clarity brush and “painted” the 
background, foreground, and areas between the animals. Those brush strokes 
soften the background and foreground so the animals stood out more in the 
frame. Softening the background also reduced the noise in those out-of-focus 
areas. (Most noise shows up in shadow and out-of-focus areas.)
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Adding Impact to In-Camera Images

Outtakes
Here’s the screen grab of some my outtakes, 71 in all. As you can see, some of 
the shots are out of focus, some have the road in the frame, while other show 
the animals too close to the vehicle. The key is to keep shooting until the get 
the shot.

Closing Thought
This is a shot of the same lions on a different, and overcast, day. The main dif-
ference between the two photographs: the light. Always remember: back light is 
nice light.

Thank you again for being here at Photoshop World! Enjoy the show. Also, if 
you see me walking around the halls, please don’t be shy and say hi. Ask ques-
tions, too!
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With GLYN DEWIS

Photoshop Lighting Effects for Photographers

Glyn Dewis
Photographer, Retoucher and Trainer

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s pho-
tography and retouching sees him working for national and international clients ranging from 
the BBC, Sky TV and Air New Zealand to athletes, musicians, and other industry professionals. A 
Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn also 

teaches his own series of workshops, provides one-on-one coaching and presents at events around the World cov-
ering all aspects of Adobe Photoshop from basic to advanced techniques. See his work at glyndewis.com and find 
videos on his YouTube channel at youtube.com/GlynDewis.

As a Photographer, I use light, be it natural lit in a scene or light I’ve artificially 
added in using off-camera strobes.

It’s the light in a picture that contributes to the overall mood and atmosphere 
and I always love the challenge of lighting a scene, however, it’s when I bring 
my pictures into Photoshop that I can take the lighting a step further. I can 
alter the light, I can add light, I can add special effects; all of this to help give 
the picture the mood and atmosphere that I ultimately want. 

So, in this session, we’ll be looking a mixture of lighting effects from as simple 
as adding in a realistic spotlight, to creating mystical special effects. So let’s 
now take a look at creating a lens flare and then how we can also add an addi-
tional light source into a scene quickly and easily…

Creating a Lens Flare
Step 1:
Add a new blank 
layer to the top 
of the layer stack 
and rename it 
“Light.” Grab 
a round, soft-
edged brush with 
a brush size of 
around 900 pix-
els and select a 
white foreground 
color. Then press 
once to apply a 
brushstroke to the 
right side of the 
figure’s neck.
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Step 2:
Next, we’ll add in some lens flare. As you’d expect, there are lots of ways to 
do this. You could, of course, make a lens flare in Photoshop but I turned to 
Adobe Stock for the one I used in this picture.

Once the image is 
downloaded into 
Photoshop (Figure 
2), hold down Shift + 
Command (Mac) or 
Shift + Ctrl (PC) and 
press U to desaturate 
it (Figure 3). 

Then open the Levels 
adjustment by pressing 
Command + L (Mac) 
or Ctrl + L (PC), select 
the Black Sample Point 
(Figure 4), and click on 
the image just under-
neath the flare (Figure 
5). Click OK.

2

3

4
5
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Step 3:
Grab the Crop Tool (C) and move the bottom crop line upward (Figure 6), then 
press Return (Mac) or Enter (PC).

Go to Select > All, followed by Edit > Copy and then click the tab to open up 
the action figure picture. Then go to Edit > Paste, rename the new layer “Lens 
Flare” and change it’s Blend Mode to Screen. Use the Move Tool (V) to drag it 
into place on the figure’s shoulder (Figure 7).

6

7
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Add a Layer Mask and grab a large, round, soft-edged brush with a black 
foreground color. Press once with the brush just outside of the canvas area so 
that the soft, feathered area of the brush gently removes part of the lens flare 
(Figure 8).

Using the same brush press once just outside of the canvas area on the other 
side of the picture to gently remove part of the lens flare from that side too. 

Step 4:
Let’s now colorize the picture and to do 
this add a Selective Color adjustment layer 
(Figure 9), and in the properties, choose 
Neutrals from the Colors 
menu and make the fol-
lowing adjustments: 
Cyan +2%, Magenta -3%, 
Yellow -15%.

8

10

9
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Adding a Light Source
For those times when you either didn’t have enough lights with you at the time 
or you just want to add an extra light source, this technique is perfect…

Step 1:
Now we’ll use a technique I call the Never Ending Lighting Rig to add a fake 
light source coming from above. This isn’t an essential addition but it’s one that 
I tend to do quite a bit so that viewers can make sense of the lighting in the 
scene.

11
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Add a new layer to the top of the 
layer stack and rename it “Spotlight” 
(Figure 1).

Grab a round, soft-edged brush from 
the toolbar and choose a white fore-
ground color. Press down once with 
the brush in the center of the picture 
to add a soft, round spot (Figure 2). 
Then go to Edit > Free Transform and 
while holding down Shift + Option 
(Mac) or Shift + Alt (PC) click and 
drag outward beyond the frame to 
increase the size of the soft, round 
spot (Figure 3). Press Return (Mac) or 
Enter (PC).

1

2

3
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Use the Move Tool (V) to drag the spotlight upward so that just the softest 
bottom area is visible (Figure 4).

4
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With MATT KLOSKOWSKI

Photo Styling with Photoshop Color Lookup Tables 

To access instructor provided digital downloads, visit: photoshopworld.com/
downloads. The password is: PSWDDOR2018193418.

Matt Kloskowski
Landscape  Photographer  and Photoshop & Lightroom Educator

I’m a Photography mentor/coach that specializes in Outdoor/Landscape/Nature photography  
and editing with Photoshop, Lightroom and ON1 apps. I’m also very honored to be included 
as a Sony Artisan of Imagery, and author of over 15 books on post-processing (Lightroom & 
Photoshop) and photography. I call myself a Landscape and outdoor photographer, because  

landscapes seems kinda limiting. I like to shoot, teach about, and post-process just about everything that has  
to do with the outdoors and traveling.
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With DAVE CROSS

Selections and Masks Demystified

Dave Cross
Certified Guru and Technical Trainer

For 25 years Dave Cross has been helping photographers and creative professionals get the most 
out of their Adobe software. Dave has a Bachelor of Education, is an Adobe Certified Instructor 
and is a Certified Technical Trainer. Dave has taught for Adobe, at Photoshop World, the Texas 
School of Photography, the Santa Fe Workshops, at ShutterFest and is a frequent instructor on 

CreativeLive. He offers online training at online.davecrossworkshops.com. In 2009 Dave was inducted into the 
Photoshop Hall of Fame.

Making selections – quickly and accurately – is one of the most important skills 
to master in Photoshop as it is often the first step in working with layers, making 
Masks etc. In this session, we’ll look at effective methods for making selections 
and working with Masks. We’ll start with a quick look at “traditional” selection 
methods and then explore how the Select and Mask workspace is a potential 
game changer. Along the way I’ll share some “secrets” for success.
 
Selections versus Masks
Making an accurate selection is just on step in the process – you wouldn’t make 
a selection and then stop there. A selection means that only certain pixels are 
active, then you do something with those pixels such as add paint, add an 
adjustment layer, or make a Layer Mask. Once a selection is “gone” you typi-
cally have to start again to create the selection, while a mask remains editable as 
long as it is available. A selection is identified by “marching ants” while a mask is 
made up of shades of gray: white represents the selected area and black repre-
sents areas that are not selected. 
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Selection Secret #1
Always aim to “end up” with a great selection.

This means that while you may sometimes be able to make a great selection 
with one tool, chances are it’s going to take several steps and tools. As we know, 
there are many options for making selections both in tools and under menus 
and it’s very likely that you’ll end up using multiple functions together.
 
For me, it’s always made better sense to think “end up with a great selection” 
rather than “selecting something.”
 
The Selection Tools and Commands
Photoshop comes with a series of selection tools and commands, each with 
their own advantages and each designed for different selection situations.
 
Shape Selection tools
n   Rectangular Marquee – for selecting rectangles and squares
n   Elliptical Marquee – for selecting ovals and circles
n   Single Column Marquee – for a one-pixel column selection
n   Single Row Marquee – for a one-pixel row selection
n   Polygonal Lasso – for selecting straight-edged shapes
n   Lasso – for selecting free form shapes
 
Automated Selection tools and Commands
n   Magic Wand – automatic selection based on a range of colors (single click)
n   Magnetic Lasso – senses edges to help make a selection
n    Color Range – a command that selects by ranges of colors, with options 

to adjust
n   Quick Selection – the “edge detection” tool (click and drag)
n   Focus Area – makes a selection based on depth of field
n    Select Subject – makes an automation selection of the perceived subject 

(CC 2018)
 
Other Selection methods
n    Quick Mask – view and edit the selection as a colored overlay
n    Load Selections from other sources – use Layers or Channels to create selections
n    Grow – expand an existing selection
n    Similar – select pixels similar to existing selection
n    Pen tool – draw with the Pen tool and convert the path into a selection
n    Transform Selection – adjust a selection using transformation handles
n    Modify commands – a series of commands to adjust a selection
n    Save Selection – a means to “store” a selection for later use
n    Extract – highlight the edges to extract an area
n    Select and Mask – a workspace to refine and adjust the selection

With DAVE CROSS

Selections and Masks Demystified
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Needless to say, sometimes it will be very 
clear which tool to use: if you need to 
select a coin, use the Elliptical Marquee 
tool. In other cases you’ll have to experi-
ment with various tools. 
 
Selection Secret #2
Try the automated tools first – the selec-
tion may not be perfect but these tools will 
often give you a really good start, more 
quickly than using a manual alternative.
 
Selection Secret #3
Fine-tune your selection using keyboard modifiers and/or Transform Selection.

If you’ve made a starting selection and it’s not quite right you can use the same 
selection tool, or a different one, to tweak the selection:
 
n    Hold down Shift to add to the existing selection
n    Hold down Option (PC: Alt) to remove from an existing selection

 
For example, start with a selection made with the Quick Selection tool and then 
switch to the Lasso tool to add the missing areas (with the Shift key held down).
 
Use Transform Selection to click-and-drag on handles to resize a selection to fit 
the shape you need.
 
Selection Secret #4
Sometimes it’s easier to select the opposite of what you need.

Make a selection of the area outside of what you need selected and then 
Inverse the selection: press Command-Shift-I (PC: Ctrl-Shift-I) and the opposite 
will be selected.
 
Selection Bonus
Temporarily edit your photo to help make a 
selection.

Sometimes it’s hard to make a selection since 
you can’t see the edges very well. If the per-
formance of the selections tool is mediocre 
because it’s hard to see the edges, temporar-
ily add an Adjustment Layer to help make the 
selection. For example, add a Levels Adjustment 

With DAVE CROSS

Selections and Masks Demystified
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Layer and make 
a dramatic 
change so it’s 
easier to see 
the edges that 
you’re trying to 
select. 
 

Use a selection 
tool and once 
you’re finished 
making the 
selection, delete the Adjustment Layer.
 

Selection Secret #5
Make sure you can see what you’re doing.

One of the challenges 
of making selections is 
being able to tell how 
accurate your selection 
really is: the selection 
edges (a.k.a. Marching 
ants) sometimes make it 
difficult to see how well 
you’re doing. For these 
situations try using 
Quick Mask. With an 
active selection, click on 
the Quick Mask button 
or tap Q. The selection 
displays with a colored 
overlay that represents 
the areas that are not 
selected. The selected 
areas have no colored 
overlay. 
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To fine-tune the selection in Quick Mask, paint with black to add to the colored 
overlay and remove from the selection. To add to the selection, paint with white. 
You can use any method of “painting” from using the Brush tool to making a 
selection and filled with black or white.
 
Hint: If you use the brush tool, the size and edge of the brush will have an influ-
ence on the selection: use smaller brushes for detailed areas, use hard-edged 
brushes to create non-feathered selections, and use soft-edged brushes to cre-
ate feathered edges.
 
Selection Secret #6
Move the subject onto the new background first.

A common reason for mak-
ing a selection is to create 
a layer Mask to composite 
a subject onto a new back-
ground image. With that 
in mind, before you start 
making a selection drag the 
subject onto the new back-
ground. That way every deci-
sion you make is in the context 
of the new background. 
 
The alternate would be to 
make a selection of your 
subject without knowing if 
you are working harder than 
necessary, for example select-
ing small hairs that don’t end 
up being visible on the new 
background.
 

Selection Secret #7
Use Select and Mask.

One of the best features in Photoshop CC is the Select and Mask workspace. 
One of its greatest strengths is helping to create a better edge, even from a 
basic selection. After making a selection, click on the button (in the Options Bar) 
to enter the Select and Mask workspace.
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First, pick the view you want to work with: 
 
Onion Skin (O): Variable transparency of the 
background
Marching Ants (M): Selection edges
Overlay (Y): Quick Mask
On Black (A): On a black background
On White (T): On a white background
Black & White (K): The Mask
On Layers (Y): On a transparent layer
 
Press F to toggle through the previews or X 
to temporarily see the original view.
 
I tend to spend most of my time in On Layers 
view and occasionally switch to 
Black & White view so I can preview 
what the layer Mask will look like.

If you notice any areas that are selected and shouldn’t be, or are miss-
ing from your selection, you can fine-tune the selection using the 
Selection tools built-in to the workspace. 
 
The Quick Selection Tool (W): Works just like the regular Quick 
Selection tool
Refine Edge Brush Tool (R):
Brush Tool (B): “Paint” to select areas
Lasso Tool (L): Works the same as the regular Lasso tool
Hand Tool (H): Scroll the view
Zoom Tool: (Z): Zoom in
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With each tool, use the Option/Alt key to reverse the effect of the tool, for 
example Option/Alt will remove from selections with the Quick Selection tool.
 
It’s also possible to start in the Select and Mask workspace without first making 
a selection: use the Onion Skin view with a mid-range opacity and then use the 
selection tools to make your selection.
 
Use the Refine Radius tool to brush over the areas of transition between hard 
and soft edges. You can also try turning on Smart Radius in an effort to (theo-
retically) preserve both hard and soft edges.
 
Remember to check the edges in the context of the new background – if you’re 
in Onion Skin view change the transparency to 100%.
 
I also make sure to check 
the Black & White view to 
see what your layer Mask will 
look like: if you see wisps of 
detail in this view, that can 
be improved after the Mask 
has been made.
 
Once you’re happy with the 
edge go to the Output area 
to choose your output meth-
od, typically Layer Mask.
 
If you notice a small fringe of color use the Decontaminate Colors option. 
By default this will create a copy of your layer with a Layer Mask, preserving 
your original layer (since the Decontaminate Color option changes the pixels 
of the layer).
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Key Technique: Select in Pieces
Select and Mask can do an amaz-
ing job on fine detail like hair. Many 
times you’ll get even better results 
if you first make a duplicate of 
your subject layer: then you can 
make a selection of just the hair 
on one layer and make a separate 
selection of the rest of the body 
on the other layer. That way you 
can use different settings for the 
hair and the harder edges of the 
body. You’ll end up with two sepa-
rate layers that you can combine 
to “end up with” a great Mask. 

 
Selection Secret #8
A Second Chance.

Once a Layer Mask has been created have a “second chance” to access the 
same controls to fine-tune the Mask. To access these controls, double-click on 
the Layer Mask. The first time, 
you’ll be asked whether you want 
to view the Properties panel 
or enter the Select and Mask 
Workspace. Once in the Select 
and Mask Workspace you can 
use the same methods to tweak 
your Layer Mask (it will update the existing Mask rather than create a new one). 
 
The Magic of Overlay
Quite often you’ll get a Layer Mask that is very close to what you want but you 
might still be missing small details such as fine hairs. Rather than spending too 
much time in the Select and 
Mask workspace, sometimes 
you can get the result you 
want by painting on the Layer 
Mask – in Overlay mode.
  
To view the Mask, hold down 
Option/Alt and click on the 
Mask thumbnail.
Look for areas where you 
see light gray that should 
be white. 
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Change the settings of the Brush tool to Overlay mode and 50% opacity. Set 
your Foreground color to white.
 
Once again hold down Option/Alt and click on the Mask thumbnail. This will 
let you paint on the Mask while viewing the context of the subject on the 
new background. 
 
Paint over light gray areas where you want to see mode detail in those fine 
hairs. Use caution to not paint too much over the same area as it can very 
quickly look artificial.
 
If there are areas that are dark gray that should be black, switch the Foreground 
color to black and use Overlay mode.
 
Useful Shortcuts:
Press Option-Shift-O (PC: Alt-Shift-O) to change the Brush to Overlay mode.
Press Option-Shift-N (PC: Alt-Shift-N) to change the Brush to Normal mode.
Press 1-9 to change the Brush opacity to 10 - 90%. Press 0 for 100% opacity.
Press X to swap between black and white as the Foreground color.
 
Paste Into
This is a very effective way to create a Layer Mask that is not linked with the 
layer – perfect for situations such as replacing a sky. Start by making a selec-
tion of the sky. In this example, don’t worry about selecting small details such 
as trees and the see-through balcony. (Here’s the selection viewed in Quick 
Mask mode). 

Then switch to the photo of the sky, Select All, and Copy.
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Back in the original photo, make sure you are in regular mode (not Quick Mask) 
and from the Edit menu choose Paste Special>Paste Into. This will create a new 
Layer with an unlinked Layer Mask, making it easy to use the Move tool to repo-
sition the new sky.

 
Finally, lower the opacity of the sky 
layer: this will help it blend in and you’ll 
be able to see the fine details such as 
the trees and see-through balcony.
 

Hint: Start with a sky that’s a little more 
saturated than you’ll need, so that 
when you lower the opacity it will look 
appropriate.

In this example an effective finish-
ing touch might be to duplicate the 
sky layer, use Free Transform to Flip 
Vertical and then repaint the Mask so 
the sky only shows in some areas of 
the water. Then lower the opacity and 
experiment with Blend Modes.
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Paste on a Mask
Here’s an interesting cre-
ative possibility: rather 
than creating a Mask from 
a selection, paste a photo 
onto a Layer Mask. To 
do this you have to view 
the Layer Mask (or a new 
layer will be created) by 
holding down Option/Alt 
and clicking on the Layer 
Mask thumbnail.
 



61

Selections and Masks Demystified
With DAVE CROSS notes

Switch to the texture photo, Select 
All and Copy.
 
Switch back to the photo and Paste 
onto the Mask. Free Transform if 
necessary to fit the Mask.
To get different results you can 
try Inverting the Mask, using the 
Properties panel to experiment 
with Density and/or Feather, and/
or painting on the Mask in areas 
where you don’t want the texture 
to be as obvious.
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Mastering Photoshop Blending Modes

Jesús Ramirez
Digital Expert, Speaker, and Educator

Jesús Ramirez is a digital graphics expert, speaker, and educator specializing in Adobe Photoshop. 
He is an Adobe Community Professional, and a content creator for the Adobe Creative Cloud 
Blog. Jesús is best known as the founder of the Youtube training channel: Photoshop Training 
Channel. He has been a speaker at Adobe MAX, Adobe SUMMIT, Adobe MAKE IT, and many other 

conferences and industry events.

For this workbook, I wanted to give you a quick overview of what Blending 
Modes are and how they work. 

When Were Blend Modes Added to Photoshop?
Blending Modes have been around since 1994 when Layers first were added in 
Photoshop 3.0.

The 19 original Blending Modes are: Normal, Dissolve, Darken, Multiply, Color, 
Burn, Darker Color, Lighten Screen, Color Dodge, Lighter Color, Overlay, Soft 
Light, Hard Light, Difference, Exclusion, Hue, Saturation, Color, and Luminosity.

In 2002, five Blending Modes were added to Photoshop 7 along with the Fill 
slider. Linear Dodge (Add), Linear Burn, Vivid Light, Linear Light, and Pin Light.

Hard Mix was added in 2003 to Photoshop CS. Subtract and Divide were 
added to Photoshop CS5 in 2010.

As of Photoshop CC 2018, there are 27 Blending Modes, and three additional 
Blending Modes not available for layers.  They are Behind and Clear for paint-
ing tools and Pass Through for groups.

Opacity vs. Fill with Blending Modes
19 out of the 27 Blending Modes behave the same way when Fill is adjusted, 
compared to when Opacity is adjusted. However, eight Blending Modes give 
you a different result when Fill is changed compared to Opacity.

It is crucial to understand the difference between these sliders because this 
additional method of blending pixels extends the capabilities of Blending 
Modes. More importantly, the blend tends to be more aesthetically pleasing 
when using Fill rather than Opacity with these eight Blending Modes.

In the example below, you can see the difference of a layer set to the Hard Mix 
Blending Mode with an Opacity at 50%, and a Fill of 50%.
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The Blending Modes that are part of this group of 8 are Color Burn, Linear 
Burn, Color Dodge, Linear Dodge (Add), Vivid Light, Linear Light, Hard Mix, 
and Difference.

“Transparency Shapes Layer” Check Box
The 8 Blending Modes in this group, also give you an extra level of blending 
by un-checking the “Transparency Shapes Layer” checkbox in the Advanced 
Blending Options in the Layer Style panel.
In the example below, you can see how Linear Light blends differently when 

“Transparency Shapes Layer” is unchecked. Notice how the edges of the circles 
blend differently on the example on the right.

Base + Blend = Result
To better understand how Blending Modes work, you should remember these 
terms and a simple equation. 

The “Base” color is the original color in the image.

The “Blend” color is the color applied using a painting or editing tool.

The “Result” color is the color resulting from the blend.

The Base plus the Blend equals the result.

How the Base and the Blend mix depends on the algorithm (Blending Mode) 
that you select.
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Blend Mode Math
If you are interested in how the math behind Blend Modes work, I’ve created a 
simplified explanation.

Photoshop uses “Standardized” values to calculate the blend. The luminance 
values in Blending Mode math range from 0 (black) to 1 (white). However, 
Photoshop uses 0 (black) to 255 (white) to represent luminance values in RGB. 
Photoshop has to do a conversion to make it work. Black is still 0, but white 
becomes 1. 50% gray (128) becomes 0.5, and so on.

To convert an RGB luminance value to a standardized value, dive it by 255. For 
example, divide 192 (light gray) by 255, and you get 0.75 (192÷255=0.75).

Keep in mind that when working with numbers between 0 and 1, multiplication 
and subtraction result in lower numbers (decreased brightness), while addition 
and division result in higher numbers (increased brightness).

Math Sample:
A = Blend Layer Standardized Value
B = Base Layer Standardized Value

Multiply:
AxB = Result

Color Dodge:
B÷(1-A) = Result
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Adobe provides descriptions on each Blending Mode, but they do not provide 
the mathematical equations behind them. If you would like to find out more 
about Blending Mode math, check out the Wikipedia page on Blend Modes.
https://en.wikipedia.org/wiki/Blend_modes

Blending Mode Categories
You do not need to remember what each of the 27 Layer Blending Modes do. 
Simply remember one of the 6 Blending Mode categories (Normal, Darken, 
Lighten, Contrast, Inversion, and Component), and look for your desired effect 
in that category.

Normal

Darken

Lighten

Contrast

Inversion

Component

Each Blend Mode Explained
In the examples below, we will explain each of the 6 Blend Mode categories 
(Normal, Darken, Lighten, Contrast, Inversion, and Component) as well as all 
the Blend Mode in within each category.

The graphics in each section will show the outcome of each Blend Mode at 
100% opacity unless otherwise noted. 

Each example contains two Blend layers, a grayscale luminosity layer, and a 
color layer. And a photo as the Base layer.
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Normal Blending Modes
The Blending Modes in this category do not have algorithms that blend pixels. 
Instead, the Opacity and Fill sliders control the blend between layers.

Normal
“Normal” is the default Blending Mode for Photoshop layers. Opaque pixels 
will cover the pixels directly below them without applying any math or algo-
rithm applied to them. You can, of course, reduce the opacity of the layer to 
reveal the pixels below.

Dissolve
The Dissolve Blending Mode does not blend any pixels either. Dissolve only 
reveals the pixels below when the Opacity of the layer is reduced. The pixels 
below are revealed through a dither pattern (noise) whose intensity is based 
on the Opacity. 

Darken Blending Modes
As the name implies, the Blending Modes in the Darken category will turn the 
“Result” colors darker. Anything that is white in the blend layer will become 
invisible, and anything that is darker than white is going to have some dark-
ening effect on the pixels below it.

Darken
The Darken Blending Mode looks at the luminance values in each of the RGB 
channels and selects either the base color or blend color depending on which 
is darker. 

Simply put, this Blending Mode does not blend pixels, it only compares the 
base and blend colors, and it keeps the darkest of the two. 



67

Mastering Photoshop Blending Modes
With JESÚS RAMIREZ notes

If the blend layer and the base layer color are the same, then there is no change.

Multiply
Multiply is one of the most popular Blending Modes in Photoshop. I’m sure that 
you have used it many times before.

This Blending Mode multiplies the luminosity of the base color by the blend 
color. The resulting color is always a darker color. White produces no change, 
while the black pixels remain. 

Multiply is a great Blending Mode for darkening images or creating shadows.

Color Burn
Color Burn is the first of the eight Blending Modes in Photoshop that react  
differently when Opacity is adjusted compared to Fill.

The Color Burn Blending Mode gives you a darker result than Multiply by 
increasing the contrast between the base and the blend colors, resulting in 
more highly saturated mid-tones and reduced highlights. 

The result is very similar to the effect you would get when you use the Burn 
Tool to darken an image.
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Linear Burn
Linear Burn decreases the brightness of the base color based on the value of the 
blend color. The result is darker than Multiply but less saturated than Color Burn. 

Linear Burn also produces the most contrast in darker colors than any of the 
other Blending Modes in the Darker group.

Linear Burn blends differently when Fill Opacity is adjusted, compared to when 
Opacity is adjusted.

*Introduced in Photoshop 7.

Darker Color
The Darker Color Blending Mode is very similar to Darken. This Blending Mode 
does not blend pixels. It only compares the base and blend colors, and it keeps 
the darkest of the two. 

The difference is that Darker Color looks at the composite of all the RGB chan-
nels, whereas Darken looks at each RGB channel individually to come up with a 
final blend.

Lighten Blending Modes
The Blending Modes in this category and re opposites, or complementary col-
ors from the Darken category. These Blending Modes will turn the “Result” col-
ors Brighter. 

Anything that is black in the blend layer will become invisible, and anything 
that is brighter than black is going to have some darkening effect on the pixels 
below it.
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Lighten
The Lighten Blending Mode looks at the base color and blend color, and it 
keeps whichever one of the two is the lightest. If the blend colors and the base 
colors are the same, then no change is applied. 

As with the Darken Blending Mode, Lighten looks at the three RGB channels 
separately when blending the pixels.

Screen
Screen is another of Photoshop’s most popular Blending Modes. The resulting 
color is always a brighter color. Black produces no change, while the brighter 
pixels remain. 

Screen is a great Blending Mode for brightening images or creating highlight 

Color Dodge
Color Dodge is the third of the eight special Blending Modes, which blends dif-
ferently when Fill is adjusted, compared to when Opacity is adjusted.

The Color Dodge Blending Mode gives you a brighter effect than Screen by 
decreasing the contrast between the base and the blend colors, resulting in 
saturated mid-tones and blown highlights.

The effect is very similar to the result you would get when using the Dodge 
Tool to brighten up an image.
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Linear Dodge (Add)
Linear Dodge (Add) produces similar but stronger results than Screen or Color 
Dodge. This Blending Mode looks at the color information in each channel and 
brightens the base color to reflect the blend color by increasing the brightness. 
Blending with black produces no change.

Linear Dodge (Add) blends differently when Fill Opacity is adjusted, compared 
to when Opacity is adjusted.

*Introduced in Photoshop 7.

Lighter Color
Lighter Color is very similar to Lighten. This Blending Mode does not blend pix-
els. It only compares the base and blend colors, and it keeps the brightest of 
the two. 

The difference is that Lighter Color looks at the composite of all the RGB chan-
nels, whereas Lighten looks at each RGB channel individually to come up with 
a final blend.
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Contrast Blending Modes
The Blending Modes in this category are a mixture between the Darken and the 
Lighten Blending Modes. They create contrast by both lightening and darkening 
the result colors by using complementary Blending Modes to create the blend.

Photoshop checks to see if the colors are darker than 50% gray or lighter than 
50% gray. If the colors are darker than 50% gray, a darkening Blending Mode is 
applied. If the colors are brighter than 50% gray, a brightening Blending Mode 
is applied.

Except for Hard Mix, all the Blending Modes in this category turn 50% gray 
transparent.

Overlay
Overlay is another of Photoshop’s most widely used Blending Modes. It is a 
combination of Multiply and Screen with the base layer always shining through. 
Overlay uses the Screen Blending Mode at half strength on colors lighter than 
50% gray. And the Multiply Blending Mode at half strength on colors darker 
than 50% gray. 50% gray itself becomes transparent. Also, note that “half-
strength” does not mean, Opacity at 50%.

Another way of thinking about Overlay is by thinking of shifting mid-tones. 
Dark blend colors shift the mid-tones to darker colors, light-tones shift the 
mid-tones to brighter colors.

One difference between the Overlay Blending Mode and the other Contrast 
Blending Modes is that it makes its calculations based on the brightness of the 
colors in the base layer. All the other Contrast Blending Modes make their cal-
culations based on the brightness of the blend layer.

Overlay (alongside Hard Light) is part of the first set of Commuted Blending 
Modes in Photoshop. A set of commuted Blending Modes will give you the 
same result when you apply one Blending Mode to the blend layer, as when 
you apply the corresponded Commuted Blend Mode to the base layer, and 
then reversing the order of the layers.

In other words, if you apply the Overlay Blending Mode to the blend layer, you 
will get the same result, as when you apply the Hard-Light Blending Mode to 
the Base layer, then reverse the order of the layers.
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Soft Light
Soft Light is very much like Overlay. It applies either a darkening or lightening 
effect depending on the luminance values, but in a much subtler way. You can 
think of Soft Light as a softer version of Overlay without the harsh contrast.

Hard Light
Hard Light combines the Multiply and Screen Blending Modes using the bright-
ness values of Blend layer to make its calculations. Overlay uses the base layer.
The results with Hard Light tend to be intense. In many cases, you will have to 
reduce the Opacity to get better results.

Hard Light sounds like it would have something in common with Soft Light, 
but it does not. It is much more closely related to Overlay. They are both part 
of the first set of Commuted Blending Modes.

Vivid Light
You can think of Vivid Light as an extreme version of Overlay and Soft Light. 
Anything darker than 50% gray is darkened, and anything lighter than 50% 
gray is Lighten.

Vivid Light is one of those Blending Modes where you may want to adjust the 
opacity since 100% opacity is generally too strong.
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Vivid Light is the fifth Blending Mode of eight that give you different results 
when you reduce the fill compared to opacity.
 
*Introduced in Photoshop 7.

Linear Light
Linear Light uses a combination of the Linear Dodge Blending on lighter pixels 
and a Linear Burn on darker pixels.

Typically, the resulting colors are extreme, and you may want to use the 
Opacity or Fill sliders to adjust it.

Linear Lights blends differently when Fill Opacity is adjusted, compared to 
when Opacity is adjusted.

*Introduced in Photoshop 7.

 
Pin Light
Pin Light is an extreme Blending Mode that performs a Darken and Lighten 
Blending Mode simultaneously. It can result in patches or blotches, and it com-
pletely removes all mid-tones.

*Introduced in Photoshop 7.

Hard Mix
Hard Mix is the seventh Blending Mode in the contrast group and the seventh 
of the special 8 Blending Modes. It applies the blend by adding the value of 
each RGB channel into the blend layer to the corresponding RGB channel in 
the base layer.
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The resulting image loses a lot of detail, and the colors can only be black, white, 
or any of the six primary colors. Red, green, blue, cyan, magenta, or yellow. 

Vivid Light is an extreme Blending Mode, but you can use Opacity and Fill 
to reduce the effect. Fill will probably be your better option for reducing the 
effect of this Blending Mode since it generally gives you better results than 
Opacity.

*Introduced in Photoshop CS.

Inversion Blending Modes
The Inversion Blending Modes look for variations between the base and blend 
layers to create the blend.

Difference
The Difference Blending Modes uses the difference between the base and 
blend pixels as the resulting blend.

White inverts the colors of the base layer. It is the same result as inverting the 
colors of the base layer by pressing Command I (PC: Ctrl I). 

Black Produces no change, while dark grays apply a slight darkening effect.

This blending mode can be extremely useful for aligning layers with similar 
content.

Difference is the eighth and final Blending Mode that react differently when Fill 
is reduced compared to Opacity.
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Exclusion
Exclusion is very similar to Difference. Blending with white inverts the base 
color values, while blending with black produces no change. However, Blending 
with 50% gray produces 50% gray.

Subtract
The Subtract Blending Mode subtracts pixel values from the base layer. This 
Blending Mode drastically darkens pixels by subtracting brightness.

Black has no effect. The result gets darker only as the blend values get brighter.

Notice how the light areas of the gradient are almost pure black, while the 
dark areas of the gradient produced a very small change.

*Introduced in Photoshop CS5.

Divide
Divide produces the opposite effect as Subtract.

White has no effect. The result gets brighter only as the blend values get darker.
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Dark areas of the blend layer produce bright colors, while the light areas of the 
blend layer produced a very small change.
*Introduced in Photoshop CS5.

Component Blending Modes
The component Blending Modes use different combinations of the primary 
color components (hue, saturation, and brightness) to create the blend.

Hue
The Hue Blending Mode preserves the luminosity and saturation of the base 
pixels while adopting the hue of the blend pixels.

Hue can be used to change hues in a layer while maintaining the tones and 
saturation of the original.

Saturation
The Saturation Blending Mode preserves the luminosity and hue of the base 
layer while adopting the saturation of the blend layer.

A black-and-white blend layer also turns the image into grayscale because 
none of the pixels in the luminosity layer have saturation.

Color
The Color Blending Mode preserves the luminosity of the base layer while 
adopting the hue and saturation of the blend layer. The Color Blending Mode is 
ideal for coloring monochromatic images.

Also, Color, along with the Luminosity Blending Mode, is the second pair of 
Commuted Blending Modes.
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If you apply the Color Blending Mode to the blend layer, you will get the same 
result, as when you apply the Luminosity Blending Mode to the Base layer, 
then reverse the order of the layers.

Luminosity
Luminosity preserves the hue and saturation of the base layer while adopting 
the luminosity of the blend layer.

Pass Through Blending Mode
When you select a group, you will notice that the default Blending Mode is not 
Normal. Instead, it is “Pass Through.” 

The Pass Through Blending Mode tells Photoshop to treat all the layers within 
a group to behave as if they were just part of a regular layer stack and not part 
of the group. The group is only used as an organizational tool and all the layers 
all blend as you would expect.

However, if you changed the Pass Through Blending Mode to any other blend-
ing mode, Photoshop will first blend the layers in the group, then it will blend 
the resulting composite with the layers below it using the Blending Mode that 
you selected.

This is the same result as merging together all the layers in a group and then 
applying a Blending Mode.

For this reason, you can use it to create some great effects especially when 
compositing. You can set a Group’s Blending Mode to Normal, and all the adjust-
ment layers inside of the group will only affect the contents of that group.
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Blending Modes with 32-Bit Images
Only 15 blending modes are available when you are working with 32-bit imag-
es. They are: Normal, Dissolve, Darken, Multiply, Lighten, Linear Dodge (Add), 
Difference, Hue, Saturation, Color, Luminosity, Lighter Color, and Darker Color.

Commuted Blending Modes
There are two sets of Commuted Blending Modes, Overlay and Hard Light, and 
Color and Luminosity.

A set of Commuted Blending Modes will give you the same result when you 
apply one Blending Mode to the blend layer, as when you apply the corre-
sponded Commuted Blend Mode to the base layer, and then reverse the order 
of the layers.

For example, if you apply the Overlay Blend Mode to the blend layer, you will 
get the same result, as when you apply the Hard-Light Blend Mode to the base 
layer, then reverse the order of the layers.

Blending Mode Keyboard Shortcuts
You can change the Blending Mode of a layer by 
clicking on the drop-down and selecting one from 
the list. Alternatively, you can use the Photoshop 
keyboard shortcuts for Blend Modes. Press, Shift + 
to go down to the next Blending Mode. Or, Shift – 
to move up the list.

If you have a painting tool active, this shortcut will 
change the Blending Mode of the tool instead of 
the layer. To prevent this from happening, get in 
the habit of pressing the V key to select the Move 
tool, then press Shift + or Shift – to scroll through 
the Blending Modes.

If the focus, the blue highlight, is around the 
Blending Mode drop-down menu, these shortcuts 
will not work. Simply hit Enter or Return on the 
Mac to remove the focus from the drop-down, 
then apply any shortcut that you would like.
Except for Subtract and Divide, the two Blending 
Modes added in Photoshop CS5 in 2010, each of 
the Blend Modes has a keyboard shortcut that you 
can use to apply it to a layer.

However, I don’t recommend learning all of them. Only learn the ones you use 
most often. Most of the time I only use Screen, Multiply, Overlay, Soft Light, 
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Color, and Luminously. Those are the only blend mode keyboard shortcuts I 
have memorized.

To select a Blending mode press Alt Shift on Windows, or Option Shift on the 
Mac, then press the corresponding letter to get you the Blending Mode that 
you would like to use.

All Keyboard Shortcuts
Normal: Shift Alt (Mac: Option) N
Dissolve: Shift Alt (Mac: Option) I

Darken: Shift Alt (Mac: Option) K
Multiply: Shift Alt (Mac: Option) M
Color Burn: Shift Alt (Mac: Option) B
Linear Burn: Shift Alt (Mac: Option) A

Lighten: Shift Alt (Mac: Option) G
Screen: Shift Alt (Mac: Option) S
Color Dodge: Shift Alt (Mac: Option) D
Linear Dodge: Shift Alt (Mac: Option) W

Overlay: Shift Alt (Mac: Option) O
Soft Light: Shift Alt (Mac: Option) F
Hard Light: Shift Alt (Mac: Option) H
Vivid Light: Shift Alt (Mac: Option) V
Linear Light: Shift Alt (Mac: Option) J
Pin Light: Shift Alt (Mac: Option) Z
Hard Mix: Shift Alt (Mac: Option) L

Difference: Shift Alt (Mac: Option) E
Exclusion: Shift Alt (Mac: Option) X

Hue: Shift Alt (Mac: Option) U
Saturation: Shift Alt (Mac: Option) T
Color: Shift Alt (Mac: Option) C
Luminosity: Shift Alt (Mac: Option) Y
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Intro to Illustrator

Dave Cross
Certified Guru and Technical Trainer

For 25 years Dave Cross has been helping photographers and creative professionals get the most 
out of their Adobe software. Dave has a Bachelor of Education, is an Adobe Certified Instructor 
and is a Certified Technical Trainer. Dave has taught for Adobe, at Photoshop World, the Texas 
School of Photography, the Santa Fe Workshops, at ShutterFest and is a frequent instructor on 

CreativeLive. He offers online training at online.davecrossworkshops.com. In 2009 Dave was inducted into the 
Photoshop Hall of Fame.

The goal of this session is to introduce the essentials you need to get to know to 
get started with Adobe Illustrator. Rather than go through every single tool, we’ll 
focus on the main “sets” of tools in Illustrator for creating, editing and transform-
ing shapes – and how to work with anchor points and paths, the building blocks 
of Illustrator.
 
First, a quick discussion of Illustrator versus Photoshop – and that means a com-
parison of vector graphics versus raster graphics. Photoshop images are, for the 
most part, made up of pixels. That means that the resolution of the document 
is important. 
For example, a 
small graphic 
looks good at 
its original size.
But if the 
graphic is 
enlarged, its 
edge starts to 
look pixelated. 

 

In contrast, 
Illustrator files 
are resolution-
independent: 
the graphic can 
be enlarged to 
any size without 
loosing quality. 
Both the original 
graphic and the 
enlarged ver-
sion are of equal 
quality, with sharp edges. 
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In Photoshop, unless you create a graphic using layers, it’s as if the image is 
painted on a canvas – making it challenging to “remove” a portion of a graphic. 
 
The same graphic created in Illustrator is by nature made up of separate objects. 
…making it much easier to edit individual pieces of the graphic. 

 

Paths and Anchor Points
The building blocks 
of vector graphics are 
paths and anchor points. 
Understanding these ele-
ments is a crucial factor 
in being able to create 
and edit Illustrator files. 
The path is the line that 
creates the shape and an 
anchor point is required 
every time that line needs 
to change direction. Ideally you’ll use the minimum number of anchor points to 
create a shape – for example a triangle only needs 3 anchor points. 

 

The more complex the 
shape, the more anchor 
points you need. 

With DAVE CROSS

Intro to Illustrator
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Anchor points can create square or 
curved corners on a path. 
 
As we’ll see, anchor points can be created 
automatically with many tools, or added 
(or subtracted manually).
 

Another key to working with objects is selecting the anchor points: select 
only one and you’ll be affecting only that anchor point and therefore reshap-
ing the object. 

Select all the anchor points on a path and you’ll only be able to move or trans-
form the entire object. 
 

The Direct Selection tool (the white arrow) is used to select and edit individual 
anchor points, while the Selection Tool (the black arrow) could be thought 
of as the Move tool as it will select all the anchor points and move the entire 
object. When an anchor point is selected it is solid black – unselected anchor 
points are white.
 
TIP: If all of the anchor points are selected (black) you will have to click some-
where outside the object to deselect all the anchor points and then you’ll be 
able to use the Direct Selection tool to select individual anchor points.
 

With DAVE CROSS

Intro to Illustrator
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Editing Anchor Points
A square anchor point can be 
converted to a curved anchor 
point (and vice versa) using 
the Anchor Point tool. Click 
and drag on a square anchor 
point to pull out handles to 
create a curve. 

To convert a curved point to a straight point, click once on the anchor point with 
the Anchor Point tool. 

 
You can also add additional anchor points to allow you to change the shape of 
an object. You can either switch to the Add Anchor Point tool or use the Pen 
tool to click on an existing path.  

Fill and Stroke
By default a path is just an outline that need to have 
a fill and/or stroke color applied. At the bottom of 
the toolbar are the controls for Fill (the left icon) and 
Stroke (the right icon). 
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To change either the fill or stroke, click on either icon so that it is in front. Then 
you can choose a color by using the Swatches panel, the Color panel, or by dou-
ble-clicking on the icon to open the Color Picker.

 

A path can be opened or closed: only 
a closed path will have a stroke all the 
way around the object. Here is an open 
path (left) and a closed path (right) with 
the same fill and stroke: only the closed 
path has a complete stroke.

 

What about Layers
Although you can use layers in Illustrator, it is not necessary (unlike Photoshop 
where it is pretty much a must). Because every object is separate in Illustrator, 
you can change the “stacking” order by using the Arrange commands under the 
Object menu: Bring to Front, Bring Forward, Send Backward, Send to Back.
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You can use the Layers panel to put objects on separate layers: make sure the 
object is selected before adding a new layer. Then you can use the Layers panel 
to reorder the layers, temporarily hide them, etc.

 

Most designers only use layers for very complex artwork where they need to 
create multiple versions by hiding and showing layers. In average day-to-day 
work it is not necessary to use layers.
 
Creation Tools
Although many people associate draw-
ing in Illustrator with the Pen tool, there 
are plenty of ways to create shapes that 
are simpler. Often it’s easiest to create 
a series of overlapping shapes and then 
combine them together and/or remove 
pieces from each other.

Draw the overlapping shapes and then use the 
Shape Builder tool to drag over the shapes you 
want to combine.

To subtract from a shape, create overlapping 
shapes and hold down Option (PC: Alt) and drag 
over the intersecting shapes.
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One of the latest tools for 
shape creation is the Shaper 
tool. With this tool you 
draw primitive shapes and 
Illustrator automatically gen-
erates a high quality shape 
with straight edges. For 
example, draw a quick triangle to generate an accurate triangle.
 

Or use draw some overlap-
ping lines and then use the 
Join Tool (under the Shaper 
tool) to remove unnecessary 
lines and create a closed 
shape.  
 

Even the Brush tool creates paths with anchor points: click and drag to “paint” a 
line and when you finish, the anchor points will be created.

Along with hanging the stroke color, you can also replace the stroke with a 
design from the Brush Libraries. 
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NOTE: You can change the stroke on any 
path/object using this method. 
 

Editing tools
You can edit the corner of any shape that 
has square corners to make 
them curved. Just look for 
the small “target” near the 
corner and drag to adjust 
the curve. If you have all 
anchor points selected all 
the corners will be affected. 

If only one anchor point is selected just that 
corner will be affected. 
 

You can also create a basic shape and then 
use the Eraser tool to remove areas and 
cause the path to be redrawn.

 

With the Knife tool you can drag 
to draw a path to cut an existing 
object into separate pieces. 
 

Transformation tools
There are a number of tools for transforming an object – assuming that the 
object is properly selected (all the anchor points are black). All of these tools 
share a couple of important principles: make sure the anchor points are selected 
and determine the reference point for the transformation.
 
By default the reference point 
is in the center of the selected 
object, so the transforma-
tion tool will perform relative 
to that point. For example, 
the Rotate tool will rotate the 
object around the center. 
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If you want to rotate 
around a different point, 
drag the reference point 
to a different position. 
Then move your mouse to 
the opposite side of the 
object and drag to rotate. 

 
You can apply that same 
theory to the Scale tool 
and Shear tool. 

 

It’s also possible to transform a spe-
cific amount: double-click on the tool 
to open a dialog box where you can 
enter a specific value. 

This is probably the easiest way to 
use the Reflect tool since you most 
commonly want to reflect vertically or 
horizontally. 
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The Puppet Warp tool (CC 2018) lets you add pins to 
selected objects and drag to alter the object. You can 
also use this tool on text, however, the type is converted 
to an object and can no longer be edited. 

 

Working with Text
One of the most powerful functions in Illustrator is type: you can manipulate text 
in many ways while still preserving the ability to edit the text. For example, apply 
a warp to some text… 

…and you can still edit the text properties 
(font, size, etc.) 
 

Or use the Touch Type tool to move individual characters

 

Saving Files
To preserve all the editing capabilities 
of Illustrator, save files in .ai format. 
This format can also be placed into 
Photoshop and InDesign. 
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Getting Started with InDesign

Dave Clayton
Graphic Designer

KelbyOne instructor, Dave Clayton, is a UK based graphic designer and creative specialist with 
over 30 years of experience. With a great passion for all things design, Dave has always loved 
working in InDesign, Photoshop and Illustrator. He specialises in creating branding projects and 
logos for clients and has had work published by Peachpit and KelbyOne. He is also an Adobe 

Influencer and ACA in InDesign.

Getting Started
Hopefully, you are attending this class because you are just getting started out 
with InDesign. We are going to cover some basics in this class to get you up 
and running. Once you learn these basics you’ll be able to start making docu-
ments from a simple business card to flyers, posters, and brochures.

The reason I wanted to teach this class is because I speak to so many photogra-
phers and small businesses who have the software and need business stationery 
but don’t know where to start and are a bit scared to click on that little ID app. 

The basics of InDesign pretty much cover text and image handling, how to 
personalise them, and lay them out on the page. InDesign is a powerful lay-
out tool but right off the bat we can use its simplest functions to create great 
artwork. A lot of what you apply in InDesign you have quite probably done in 
Photoshop so the software shouldn’t feel too alien.

WARNING: This is NOT a class for professional graphic designers who 
already know how to use InDesign and all of its functionality. This is aimed 
at the beginner, someone who wants to expand their abilities, and try to use 
InDesign to improve their skillset.

Also, I will be showing these tips in Adobe InDesign CC 2017 – most of the tips 
I show are available in older versions but if you have CC you should be updat-
ing your software with each release update. Some of these basics are available 
in CS6.

Introduction
Before starting this class I will be going over a few basics regarding the usage of 
InDesign and where and how it is most commonly used. I will also cover how I 
use it in my daily workflow and give you some tips along the way. There will be a 
short presentation to cover this, which will be made available for download.

To start, we will be laying out a simple newsletter type document. We will be 
placing text, choosing fonts and styles, and adding images. We will look at 
some ways to make simple tasks better automated using styles and also the 
CC library function. We will also briefly look at Typekit and Adobe Stock to 
help make your designs that little bit more professional looking.
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Preferences Housekeeping
One of the most basic but useful things to do is to start with setting up some 
preferences to help make life easier as you work on your documents. There are 
a lot of things we could set up but it can look a bit scary and we want you to 
embrace InDesign and make it your new friend!

Step One: Open InDesign
We will start up InDesign by clicking on the ID app. That was easy! 

Now you have an empty canvas 
in front of you. A quick aes-
thetic tip, you can change the 
colour of the background in 
Prefs. There are 4 choices out 
of the box and custom. I will 
show you how to change the 
colour quite easily.

Step Two: Workspace Options
One of the new features in 
CC2017 is to open up InDesign 
with a window showing your 
most recently opened files. If 
you just want a blank applica-
tion frame to open you can 
turn this feature off. Choose 
INDESIGN > PREFERENCES 
> GENERAL (or MAC: 
Command-K / PC: Ctrl-K) and 
either check or uncheck the box 
depending on your preference. 
Personally, I like to uncheck and 
always start with a blank work-
space as I can always use FILE 
> OPEN RECENT if I need to 
open previous work.

Step Three: Type Preferences
Just as a rule, I tend to tick 
everything in the type options. 
This is because once ticked, 
they are always active until you 
turn them off again. We don’t need to go through all of these but the ones that 
will be useful are ‘Enable Drag and Drop in layout View’ ‘Font Preview Size’ 
‘Show Recent Fonts Alphabetically’. I will cover some of the others just so you 
know why they are there.
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Step Four: Units and Measurements
I will apologise here, I am English and always work in millimetres, even post-
BREXIT! I realise many of you would work in inches but for the purpose of this 
class I will work in what I am comfortable with but if you are used to working 
in ‘imperial’ you’ll understand the basics of the layouts I will be showing you.

Now let’s create a new document!

Creating a New Document

Step One: How big?
Unlike Photoshop where you’ve quite possibly started with an existing image, 
we always start with a blank page work from there. This is because, as we 
touched on in the intro, InDesign is a layout tool. To enable us to create our 
first document we need to know the size of what we are creating and then 
input that into the New Document dialog box. If it was a simple one-sided 
business card we would enter 85mm width by 55mm height (or inches equiva-
lent). In this class, we will work on an A5 document, which is a preset. 

However, before we go ahead and make a new document we are going to do 
one important and time-saving thing. With InDesign open and no documents 
open, we can set InDesign to automatically use the same default font for each 
new document we create. This is an application default. It drives me crazy that 
Minion Pro is the default on my machine so I always ensure that whatever the 
primary font family I am using for that project is the default. To do this just 
click on the type tool in the left toolbar and in the top frame we’ll choose our 
default font of choice. I will cover fonts later but for now, we’ll go with Acumin 
Pro – a Typekit font that has many weight options. I’m choosing Regular and 
10pt. That’s going to be my standard copy font size and weight. We can set up 
other variations of our document, which we will cover later in the class.

So now, every new document begins with our new default font. Just to briefly 
explain why I do this, each of my clients and projects have various brand fonts 
but to have the most common one set, which is for my own personal projects, I 
always start with that and then change it depending on what I am working on. 
I also use Creative Cloud Libraries to store my client’s preferences. We’ll cover 
that later.
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First Tip – Save your document on your computer. 

Step Two: Setting up the document

Choose New Document from the File menu or press Command-N (PC: Ctrl-N) 
on the keyboard

Uncheck facing pages (for now, we’ll come back to this at the end of the tutorial)

Then set your dimensions, either manually or choose one of the presets, we 
are making a small flyer to start this tutorial so I am choosing the standard UK 
flyer size, A5. Similar to folding Letter in half and keeping it portrait.

Next, we need to understand the margins and bleed. We also have the option 
to create guides. The margin is the ‘safe area’ – anything within this is safe 
when printed, it’s not too close to the edge when the paper is trimmed. Then 
we have our bleed. For an A5 size we usually use 3-5mm (.25”) – this means 
that any image or colour you want printed to the edge will be included when 
the paper is trimmed, I always liken it to colouring outside the lines, then when 
you get your scissors and cut around the outline of the shape, it’s completely 
coloured to the very edge. We can choose an amount of columns we need 
(these settings can be adjusted once the file is set up anyway)

Lastly, we need to tell InDesign that the intent of the document is Print and our 
orientation is portrait. 

If you check the 
preview box at 
the bottom of the 
dialog box you 
can see the new 
document build-
ing behind it.

That’s it – we have 
our new blank 
document set up 
and ready to add 
content.



94

Getting Started with InDesign
With DAVE CLAYTON notes

Adding Content
As we are all mostly using images in our lives, and let’s be honest, it’s the 
images that capture our attention, we’ll start by adding an image. InDesign can 
handle most image formats except RAW. For anything RAW I suggest you save 
the image to PSD (InDesign can handle native Adobe format files such as PSD, 
AI, EPS) or JPG, TIFF etc.

TIP: InDesign doesn’t embed, it links. So when you start your project and you 
give it a home, my advice is either keep all your assets in one main folder, or 
you can create a subfolder just for photos. For a basic project like this, we 
can keep it all in one folder. If you moved this image or changed it in any way, 
InDesign will warn you!

All images and text in InDesign live in a frame. Whether you create a frame 
first or add content, it’ll end up framed. There are a few ways to add images 
but for this tutorial, I’m choosing one – AdobeStock. AdobeStock is part of 
the Creative Cloud community, once you sign up you can buy and sell images 
through the portal. The beauty of Adobe Stock is that you can download pre-
views to use until you are happy with your choice and then easily licence the 
image afterward. We’ll come to that…

Step One: In the right-hand 
panel we have an option – CC 
Libraries, click on that. You then 
have a small dialog box appear. 
As this is your first project, we’ll 
create a new Library, name it 
accordingly. This library is your 
new best friend because you 
can store a lot of info here for 
future use. 

Now we want an image. This flyer is for a fictitious 
camera club so we’re searching for ‘cameras’. As we 
scroll through the results we’ll use a suitable image 
to place into the top of our document. I’ve chosen 
one with some camera gear. Because I may change 
my mind later I am only going to save a preview for 
now. Click the drop-down arrow and choose Current 
Library and we’ll see our image. Right-click the 
image and select Place Linked.
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A small thumbnail will appear 
on the page and this is when 
we decide where we wish to 
drag out the image frame. 
Because we need some space 
for header text we’ll place the 
image frame from the left bleed 
across to the right bleed. You 
can also drag the thumbnail 
from the panel onto the page 
and do the same.

We can change this image 
later if we need to, either with 
another stock image or even 
our own. Once placed we can 
alter the size of the frame by 
clicking once on the image. 
A blue frame line will appear. 
You can adjust this but you’ll 
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notice that as you do this the frame size changes but not the image. To resize 
the frame and the image you need to click and drag a corner and hold the shift 
(for proportion) AND the CMD key to resize everything.

Another way to insert an image is to create the frame first and place an image 
inside it. To do this you need to select the frame then use the File>Place com-
mand and find your image and place it. 

Now that your image is in the frame unless you sized your frame to the exact 
size of your image, chances are you will need to resize your image. Ideally, 
you’ll want to bring in the images already sized from Photoshop to the exact 
print size that you want and at the proper resolution, you should never plan on 
sizing them up as they will be less sharp and lose detail. Images large enough 
for print is important, Adobe Stock provide 300DPI but you own images may 
not be large enough sometimes – we can see this in the LINKS panel.

The two most common methods of sizing your image to fit the frame are: 
Fit Content Proportionally and Fill Frame Proportionally. However, the Fill 
Frame Proportionally command may crop off some of your images to fill the 
frame if the image is not the same exact proportions. We’ll try both to see 
which one we like best. Choose Fitting>Fit Content Proportionally from the 
Object menu. Now hit Undo from the Edit menu and try Fitting>Fill Frame 
Proportionally from the Object menu. 

Another way is to resize the frame to where you want the image to be placed, 
then click in the ‘donut’ wheel in the middle of the image and now you can 
resize the image independently.

If you go to my Top 10 InDesign Tips class you’ll see some other ways of adding 
multiple images and images into text.

Creating Text Frames & Linking
As with your images, your text is also always in a frame. Although text can be 
put into any type of frame, if you know you’re going to be inputting text, then 
you may as well create the frame with the Type tool (T) and drag the frame 
into the area you wish to fill, much like with the image frame. This is where the 
guides and columns come into play.

Step One: Select the Type tool in the Tools panel and drag out a new text 
frame on the page full width across the top. We’ll add our header text first. 
Type out PSW CAMERA CLUB in our default font. As this is our header font we 
need it to be larger. We’ll change the font weight to BLACK. 
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Then we need to make the type fit the frame. So highlight the text and then 
click the up arrow until the type fills the box, you can also use the Character 
Panel on the right and do the same from there. However, I much rather do this 
from the keyboard. Hit Shift Command-> (PC: Shift-Ctrl->) to make the text 
larger. The opposite keystroke would be Shift-Command-< (PC: Shift-Ctrl-<) to 
make the text smaller.

We’ll add colour later!

Next, we need to add copy text.

Step Two: Drag another frame out below the image. You will now have a blink-
ing cursor, and you can just start typing. So go ahead and type the title for 
your piece/ad. You can type or copy and paste from another document, you 
can even place text from a Word Doc but we won’t be covering that today.

Step Three: Once you type your title, you’ll notice that again, by default, it’s in 
Acumin Pro 12 pt because this is what we made our default font. We’ll make 
this a little smaller, change to 10pt for now. If you also wanted to change 
the font family just highlight what you’ve just typed with the Type tool and 
then choose a different font from the Control panel at the top of the screen. 
InDesign will actually show you what the fonts look like before you choose one.

Step Four: To make your text frame smaller or larger, you can resize it with the 
Selection tool. But when you do you’ll see a problem – where did your text go??

Step Five: Here need to learn about text frame linking. Each text frame has 
an in port and an out port. These little boxes to the left and right sides of the 
frame allow you to link frames together to flow text from frame to frame. You 
can continue text from the frame you’ve already created whether you have 
created the second frame or not. To achieve this just click the out port in the 
lower-right corner of the text frame you were just working with. If you have too 
much text you will see a small red +

Step Six: You will now have a loaded cursor. From here you can drag out a 
new frame, which will automatically link the two frames together. You can link 
as many frames together as you want and they don’t even have to live on the 
same page.

Creating Paragraph and Character Styles
Once you’ve gone through the exercise of styling your text with the fonts and 
sizes that you wanted, it’s best to save those settings as style sheets so that 
you can reapply them throughout your document both now and in the future. 
This way, you can quickly format the text you create, as well as maintain con-
sistency throughout your project.
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Step One: After you get your title 
styled how you want, put your cur-
sor anywhere in it.

Step Two: Bring up the Character Styles panel

Step Three: Hold down the Option key (PC: Alt key) and click the Create New 
Style button on the little flyout menu in the top right of the styles dialog box. 
By holding down the Option key (PC: Alt key), you are given the opportunity 
to name this style at this stage. Name your style something obvious, such as 
“Title” or “Header” and click OK. Now you can put your cursor in any new 
paragraph or frame and apply your new style.

Step Four: Paragraph styles apply to the entire paragraph no matter how many 
lines it has. Character styles apply only to the highlighted characters. Let’s go 
ahead and create a Paragraph style. First, make a single word bold, italicized, 
or a different color or font.

Step Five: Now highlight your stylized copy in the main copy text frame and 
bring up the Paragraph Styles panel, which is probably right behind your 
Character Styles panel.
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Step Six: Hold down the Option key (PC: Alt key) and click the Create New 
Style button. This will prompt you with a dialog so that you can name your 
new Paragraph style. Go ahead and name it and click OK.

Step Seven: You can now highlight any copy text and apply your new style by 
selecting it in the Paragraph Styles panel.

TIP – You’ll see in the options dialog box you get the option to save these styles 
in your CC Library – go ahead and tick that. This means those styles are saved 
and when you see them in the Library panel and you have text highlighted, you 
can click on the named style in the library and it will apply it to the text.

Using Color Swatches
We mentioned color in the last exercise but 
it’s not something we’ve looked at yet.

Step One: Bring up the Swatches panel from the side.

Step Two: You will already see a selection of basic colours. If you know what 
colour you need just choose New Color Swatch from the flyout menu.

Step Three: You can now make the color you want using the sliders or you can 
choose from one of the libraries, such as Pantone. Or if you know the CMYK 
(the preference for print) just add those values. When you have the color you 
want, click OK.

Step Four: Another way to create a new color swatch is to first use the 
Eyedropper tool (I) to sample a color of something already on the page, such as 
your image. Our image doesn’t have much colour so we’d only get blacks from it. 

Step Five: We’ll use the COLOR THEME TOOL instead. Let’s add another 
image. This time the club logo. Do the same as you did for the image and 
place the logo (in this instance, an EPS file) in the bottom third column. Now 
grab the Eyedropper tool and then click on a part of the image that you want 
to grab the color palette from. 

Step Six: You will be presented with a selection of colors taken from the logo 
and two very handy options. A small grid with a + sign and next to it a small 
box with an ->

The first is to add the swatches to the swatch panel, the second is to send the 
swatches to your CC Library.

Step Seven: Now you can highlight your text and select the color you want and 
apply it and then update your styles accordingly from either panel.
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Saving your work to PDF
Now that we’ve made our docu-
ment, now is the time to get 
them off to print to share.
It would be lovely if everyone 
had InDesign and could open 
your document, but the chances 
are the person you’re send-
ing this to may not even have 
any Adobe software, let alone 
a version of InDesign*. So, the 
best way to get a document to 
another person is via PDF and 
InDesign CC makes perfect PDFs.

*Older versions of InDesign can’t open 
newer indd files, there is a workaround 
for this though.

Step One: From the File menu 
choose EXPORT
Step Two: Make sure the Format 
is Adobe PDF (Print).
Step Three: Choose a name and 
location, local or cloud and click 
the Save button.
Step Four: Now you’ll be prompt-
ed to choose your PDF settings 
in the GENERAL section. Don’t 
worry if this part looks daunting 
because Adobe includes some 
great presets for this. 

In terms of output: 
Smallest File size is good for 
email and sharing via the Web. 
High Quality Print is great for 
printing out on pretty much 
most desktop printers. 
Press Quality is what you’ll 
require when you’re send-
ing your PDF to be printed at 
a local printer or online print 
service. I always choose Small 
and Press, if I need to share a 
version for a client they get the 
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small to check it over. If they require press version then I can share with an 
online sharing site such a WETRANSFER or HIGHTAIL etc.

Step Five: Now choose MARKS AND BLEEDS – check CROP MARKS and 
BLEED AND SLUG > Use Document Bleed Settings.

Click OK and InDesign will create 
your PDF. If you checked the box to 
preview the PDF when saved it will 
automatically open up in Acrobat. 
Whilst it is saving you will see a kind 
of graphic equaliser pumping in the 
top menu bar.

Packaging and preflighting is another 
way of sending files but it’s also a 
great way to save your project. If we 
have time we will cover this, for now, 
the class today will get you started 
and confident in using InDesign.

To finesse the document we will add 
some other bits of content using the 
disciplines we have learned today.

Hopefully, by the end of this class 
should now know how to set up a 
new document, add images, add 
text, make changes to both and 
save for print. We will cover some 
other tips along the way but please 
come and ask me anything while I 
am at Photoshop World. 

You will be able to take these tips to 
create your own great artwork and 
remember – practice, practice, prac-
tice. Keep learning, keep earning!
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With TIM WALLACE

Stock Photography: How to Shoot It and Sell It in 2018

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife.

An award winning commercial photographer based in Manchester England and working 
Internationally, his work is often described as both creative and dramatic. Tim works internation-
ally with many high clients across the globe such as Jaguar Land Rover, Peugeot, Mercedes and 
Morgan as well as shooting some of the worlds most iconic brands such as Lamborghini, Aston 

Martin and Ferrari in the UK and Europe to Dodge, Chevrolet and Mustang in the US. Over recent years he has also 
broadened the AmbientLife brand to include other transport related work such as HGV Truck and large vehicle 
photography, Aviation and aircraft work, engineering and logistics. Tim is a critically acclaimed photographer whose 
work has spanned both commercial and advertising clients for over 11 years. Over the past decade AmbientLife 
have worked with a who’s who of automotive royalty, from Jaguar, Aston Martin and beyond. Tim’s work is highly 
sought after, and this is driven also by his string of awards including British Commercial Advertising Photographer 
of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my Business:
“Your Professionalism is your Brand
Your Personality is your business card
How you make your clients feel is your Trademark”
- Tim Wallace

“Selling stock is easy, we just post a load of great looking images on loads of 
these ‘stock websites’ and sit back and watch the money roll in baby!” 
- Not really if I’m honest
Tim Wallace
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In my view never in the history of mankind have so many people had access to a 
reasonable quality camera...

 
The byproduct of this is that so many people now enjoy photography and have 
the opportunity to create some really great images as well as record what is 
around them and in their daily lives, indeed platforms such as Instagram were 
created totally off this idea.  So, with so many people taking pictures each and 
every second of the day and then lots of these people then posting them all 
over the internet what can we really do to ‘sell our work’ in the context of ‘Stock’ 
and does it really have the ability to have any great value in a ever expanding 
sea of pictures?
 
Yes is does but there are a few really important things that we need to look at 
first and understand and in this class we will be discussing the things that you 
need to understand and consider if you want to sell your work properly and for 
a value.
 
I guess the first question that you are asking yourself right now is: “is it worth it, 
as it all seems a like it might be complicated...”
 
The answer is yes it is!
As a professional photographer you have some massive advantages in your 
favour and if you are not a working professional you can still make this stock 
count, you just need to understand how and why images (assets) are bought 
and sold and by who.
 
I average around $40k to $60k in stock sales each year, on year, on year and my 
work appears on the following number of ‘stock sites’ = 0.
 
This class will look not so much at where you think you should be placing all your 
work in the hope that you might sell a few at a buck each after spending hours 
and hours uploading them all, but it will look at what’s hot, what’s not, and why.
We will look at where some likely places are that your work will be found as well 
as talk about where ‘art directors’ are visiting these days to go and find work 
that fits with what they are searching for.
 
Example:
The first image here shows a Porsche that I shot in a location in Zurich in 
Switzerland, it’s a good image and that’s all great and lovely but does it really 
have any value as stock? Well it might well have some value to perhaps a com-
pany that are automotive or transport related and what to use a really nice look-
ing car image for something but…
 

With TIM WALLACE

Stock Photography: How to Shoot It and Sell It in 2018
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This second image is from a set of images that I shot of the actual location 
itself. The setting we used was an old train repair area that was now pretty 
much unused. The reason I shot this extra work for myself while I was there is 
that I KNOW that there are organizations and people out there that are look-
ing for ‘backgrounds’ just like this, these are often referred to in my profes-
sion as ‘backplates’.

With TIM WALLACE

Stock Photography: How to Shoot It and Sell It in 2018
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I shot 12 images in total of the area that day and in the last six months I have 
sold some of these for people looking to use that sort of location for a project 
that they may be working on without the ‘cost’ of going to Zurich or some-
where similar to shoot it. The last client that bought the image below from 
me was a car collector in San Diego and he bought a license for that image to 
have it printed across the entire width of his open plan car showroom building 
and across two floors high. That deal, done correctly, alone was worth a good 
healthy four-figure sum. 
 
So what really are some of the key points to consider when we now think about 
shooting stock images for sale, because that is a key point in as much as some 
of the ‘best’ stock that sells is the ones that were specifically shot as stock.

This class will look at some of these main points as well as giving you some 
pointers on perhaps what to think about while shooting those images.
 
The key things to think about when considering stock are all based around who 
might use it and how they might use it, in other words what are they most likely 
to need?
 
It would be easy to think that if we have a great landscape image it would do 
perhaps really well as a stock image but in truth you are more likely to have 
greater success with good quality images of things that are not as common, this 
is something well worth remembering. Perhaps a image of some powerful rocket 
engines may well end up doing a lot better than ‘another’ amazing pier in the 
sunset image.

If we include people in our work then we need to be prepared to understand 
that we may need permissions and ‘releases’ for those images to be able to 
sell them for commercial use. We will talk a little more on this as a group in our 
class and it is an important aspect to understand when you are looking at sell-
ing stock. 
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The same goes of we shoot an item or object that can be individually identified 
by perhaps a name or say number plate. We may need to consider that permis-
sion is required if that image is to be used in a advertising campaign. We would 
also need to ask the right questions from the proposed buyer of our image to 
determine EXACTLY how that image is going to be presented and where. These 
things are really important and it is something that we will discuss through our 
class together. Quite often not asking the right questions and ‘quoting’ for your 
stock client in the right way can be the difference between having your image 
chosen or not.

The final word…
 
Copyright and Licensing… how exciting can this be?
Well if you do not understand copyright and licensing you are simply not legally 
able to sell stock images for commercial use and if you do it is highly likely that 
one day you will end up in hot water with somebody and not covered under the 
law. So with that in mind please consider that this is really really important.
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Well for some this subject is regarded as something similar to black magic or 
something that’s very complicated, the truth is that it is really important for 
all photographers to get a handle on this because not doing so can mean you 
are not protecting your work and potentially losing quite a lot of money in 
the process.
 
On the other side of things not knowing how to discuss this properly with a 
commercial client when attempting to organize a new shoot commission and 
understand in regard to what is expected from both parties can lead to a lack of 
client confidence in your business.
 
I would say that it is very much worth considering that those of you that sell 
‘stock photography’ or indeed would like to look at doing this with better con-
fidence should also strive to learn about this subject. I have been supplying cli-
ents, magazines, books, and agencies stock photography for over 11 years now 
and it has been a valued part of my annual revenue stream that can easily lead 
to tens of thousands of dollars over a one year period.
 
First and foremost act like a business.
“You’re in business so ‘be’ in business and think like a business for both yourself 
and your clients”
 
We will discuss both licensing and copyright in our class so that you get a bet-
ter understanding on how to use it as part of your pricing on stock as well as a 
negotiating tool. Every stock image that I sell is priced differently as it depends 
on the usage and other factors that we will discuss.
 
Sometimes people can find the whole area of licensing and copyright very con-
fusing. So in simple terms these are the core facts to understand;

Copyright is about who owns the images.  
Licensing is about who has the right to reproduce the images.
 
Traditional licensing
This can be both Non-exclusive or Exclusive and means that the image is 
licensed for a specific purpose or use.  Sometimes referred to as ‘Royalty Free’ 
and ‘Rights Managed.’
 
Non-exclusive
The buyer pays a license fee for the use of the image. Be aware that another 
buyer can also purchase and use the same image however,  hence ‘Non-
Exclusive.’ The buyer must specify, each time: intended use, media, territory, and 
duration.  Pricing is based on intended use, media, duration, and territory.
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Exclusive (Rights Managed)
The buyer pays a license fee each time they use the image.  The buyer obtains 
exclusive use of an image under the terms of the license: these terms may affect 
the use, media, territory, and/or duration in which the image can by used by 
other buyers.  Rights protection can be an advantage for high-profile projects 
such as ad campaigns and promotions.  Pricing for this type of license varies and 
very much depends on the terms for the image use being requested.  If ‘exclu-
sivity’ is required then you should typically expect to pay between 25-40% more 
to guarantee an exclusive license against the image / images for the period 
agreed, normally six months.

 
Royalty Free licensing
This is the simplest form of licensing and the price is driven by the actual image 
file size to be provided. As a customer you will pay a one-off fee. You are not 
required to pay royalties on the use-by-use basis. Be aware however this type of 
license in NOT exclusive and you will not know who else is using the image.

What’s Usage?
When we talk about Usage we are referring not only to territories of usage but 
also forms of advertising such as ‘below the line’ and ‘above the line’.
 
Above The Line (ATL) and Below The Line (BTL) advertising
‘Above The Line’ and ‘Below The Line’ came into existence way back in 1954 with 
the company Procter & Gamble paying their advertising agencies a different rate 
for different forms of advertising
 
Below the line (BTL) advertising is more one to one, and involves the distribution 
of mailshots to individuals, and promotions, brochures placed at point of sale
 
Above The Line (ATL) advertising is mass media is used to promote brands and 
reach out to the target consumers. These include conventional media as we 
know it, television advertising, print media, billboards as well as Internet. 
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This is communication that is targeted to a wider spread of audience and is not 
specific to individual consumers. ATL advertising tries to reach out to the mass 
as consumer audience.
 
Hopefully at the end of our class you will have a much better idea of why some 
people seem to earn quite a lot of revenue from stock each year whereas others 
seems to just earn a few dollars here and there.
 
The key in selling stock is understanding WHAT is required, by WHO and then 
LICENSING that correctly at the right price that is within client budget for use. 
If you can do this then you will be able to stick your head up against the rest of 
the herd.

Tim Wallace (The Real Batman)
International Commercial Advertising Photographer
www.ambientlife.co.uk
Twitter - @Ambient_life
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With MATT KLOSKOWSKI

Luminosity Mask Basics in Lightroom & Photoshop  

To access instructor provided digital downloads, visit: photoshopworld.com/
downloads. The password is: PSWDDOR2018193418.

Matt Kloskowski
Landscape  Photographer  and Photoshop & Lightroom Educator

Matt is the founder of Matt Kloskowski Photography and Training. He specializes in outdoor, 
landscape, and nature photography along with editing with Photoshop, Lightroom, and ON1  
apps. Matt was inducted into the Photoshop Hall of Fame in 2014 and is the best-selling  
author of over 20 books. Matt loves to educate others and spends much of his time teaching  

seminars around the world.
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With SCOTT KELBY

Simplified Lightroom (Classic) Image Management System    

To access instructor provided digital downloads, visit: photoshopworld.com/
downloads. The password is: PSWDDOR2018193418.

Scott Kelby
Photography & Photoshop Author and Founder of KelbyOne.com

Scott is the President and CEO of KelbyOne and the original “Photoshop Guy.” He is  
the editor and publisher of Photoshop User Magazine, Conference Technical Chair for 
the Photoshop World Conference, training director and instructor for KelbyOne Live  
Seminars, and author of a string of bestselling technology and photography books.
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With JULIEANNE KOST

Using Lightroom with Photoshop: When & Why?   

To access instructor provided digital downloads, visit: photoshopworld.com/
downloads. The password is: PSWDDOR2018193418.

Examples include:
• Moving Between Lightroom and Photoshop
• Opening Multiple Photographs into a Single Photoshop File
• The Difference Between “Edit in Photoshop” and “Open as Smart Object”
• Opening Files from Lightroom into Photoshop - Round-tripping FAQ
• Exporting Images
• The Power Of Smart Objects in Photoshop
• The Difference Between “Edit in Photoshop” and “Open as Smart Object”
•  The Difference Between Duplicating a Smart Object and Creating New Smart 

Object via Copy

Julieanne Kost
Photographer, Lightroom Educator and Author

Named one of Fast Company’s “100 Most Creative People in Business,” Julieanne Kost is the 
Digital Imaging Evangelist Director at Adobe Systems, responsible for fostering relationships 
with customers through meaningful and inspirational Photoshop and Lightroom instruction. As 
a highly sought-after speaker for the industry-standard Digital Imaging franchise, she devises 
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